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Read this manual carefully before you use this machine and keep it handy for future reference. For safe and correct use, be sure to read the
Safety Information before using the machine.



Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Caution:

Use of controls or adjustments or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Two kinds of size notation are employed in this manual.

Trademarks
Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe®, PostScript®, Acrobat® and PageMaker® are registered trademarks of Adobe Systems Incor-
porated.

AppleTalk, Apple, Macintosh and Mac OS are registered trademarks of Apple Computer, Incorporated.

IPS-PRINT™ Printer Language Emulation Copyright® 2000, Oak Technology, Inc., All Rights Re-
served.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:

* The product name of Windows® 95 is Microsoft® Windows® 95

e The product name of Windows® 98 is Microsoft® Windows® 98

e The product name of Windows® Me is Microsoft® Windows® Millennium Edition (Windows Me)

» The product name of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

» The product name of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

» The product names of Windows Server® 2003 are as follows:
Microsoft® Windows Server® 2003 Standard Edition
Microsoft® Windows Server® 2003 Enterprise Edition
Microsoft® Windows Server® 2003 Web Edition

» The product name of Windows® NT are as follows:
Microsoft® Windows NT® Server 4.0
Microsoft® Windows NT® Workstation 4.0

Notes:

Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please contact your local dealer.



Manuails for This Machine

The following manuals describe the operational procedures of this machine. For
particular functions, see the relevant parts of the manual.

& Note
O Adobe Acrobat Reader/Adobe Reader is necessary to view the manuals as a
PDF file.

O To view HTML manuals, a Web browser must be installed.

% Safety Information (paper)
Describes information about the safety precautions.

% Easy Operation Guide (paper/PDF file - CD-ROM )
Describes information about the control panel and basic operations.

% Operating Instructions (PDF file - CD-ROM )
Describes operations, functions, User Tools (initial setting, mode setting, etc.)
and troubleshooting.

% Network Guide (PDF file - CD-ROM )
Describes procedures for configuring the machine and computers in a net-
work environment.

% Printer Reference (this manual)
Describes system settings and operations for the machine's printer function.

< Preparations for Use as a Printer (paper/PDF file - CD-ROM )
Describes procedures for connecting the Ethernet and USB cables to the ma-
chine.

% Manuals for DeskTopBinder Lite
DeskTopBinder Lite is a utility included on the CD-ROM labeled “Document
Management Utility”.

» DeskTopBinder Lite Setup Guide (HTML - CD-ROM *2)
Describes the installation of, and the operating environment for DeskTop-
Binder Lite in detail. This guide can be displayed from the [Setup] dialog
box when DeskTopBinder Lite is installed.

* DeskTopBinder Lite Introduction Guide (HTML - CD-ROM *2)
Describes operations of DeskTopBinder Lite and provides an overview of
its functions. This guide is added to the [Start] menu when DeskTopBinder
Lite is installed.

< Other manuals

* PostScript3 (PDF file - CD-ROM 1)

"1 Provided on the CD-ROM labeled “Operating Instructions”
"2 Provided on the CD-ROM labeled “Document Management Utility”
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How to Read This Manual

Symbols

The following set of symbols is used in this manual.

iﬁklmportant
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

5] Preparation
This symbol indicates information or preparations required prior to operating.

@ Note

This symbol indicates precautions for operation, or actions to take after abnor-
mal operation.

? Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

p Reference
This symbol indicates a reference.

[ 1]
Keys that appear on the machine's display panel.

[ 1]
Keys and buttons that appear on the computer's display.

[ ]
Keys built into the machine's control panel.
[ ]

Keys on the computer's keyboard






1. Getling Started

Control Panel
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1. Screen contrast knob
Adjusts the brightness of the display pan-

el.
2. [Image Position] key
Adjusts the position of printed images.

3. [User Tools] key

Press to change the default settings to
meet your requirements.

4. Position Setting keys
Adjusts the position of printed images.

5. [Printer Settings] key

Press to change the default settings of on-
line printing.

6. Indicators

7. [Check Modes ) key

Press this key to check settings.
8. [Program] key

Press to register frequently used settings,
or to recall registered settings.

9. [Clear Modes ] key

Press to clear previously entered copy job
settings.

10. [Hold Data-in] key
Press to reject the online print temporari-
ly.

20 2122 23 24
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11. [Master Making] mode select key
Press to select the master making mode.

12. [Auto Cycle] key

Press to make masters and prints in a sin-
gle operation.

13. [Print] mode select key
Press to select the print mode.

14. Main power indicator

The main power indicator lights up when
the main power switch is turned on.

15. [Proof] key
Press to make a proof print.
Same as 22.

16. Data In indicator (Green)
* On: Master Making in progress
* Blinking: Data being received

¢ Off: Master Making and printing are
completed.

17. Error indicator (Red)

e On: An error has occurred. Master
Making and printing stops.

e Off: Normal status

18. Speed setting keys
Press to adjust the printing speed.



Getting Started

19. [Initial position] key
Press to reset to the default image posi-
tion.

20. Number keys
Press to enter the desired number of
prints and data for selected modes.

21. [Clear/Stop] key

e (Clear
Press to delete a number entered.

s Stop
Press to stop a job in progress.
22, [Proof] key

Press to make a proof print.

& Note
O Same as 15.

23. [Start] key

Press to start making masters or printing.

24. Operation switch

Press this switch again to return to the
ready state.



Control Panel

Display Panel

The display panel shows machine status, error messages and function menus.

The function items displayed serve as selector keys. You can select or specify an
item by lightly pressing the key.

When you select or specify an item on the display panel, it is highlighted like
B3 Keys appearing as [ OK | cannot be used.

ﬁlmportant
O A force or impact of more than 30 N (about 3 kgf) will damage the display
panel.

By default the screen is displayed when you the power is on.

Common Key Operations

The display panel shows the printer status, error message, and function menu.

W Cyele Setting O Read (Online)

28 SEP. 2008 6:23

Standand
F Feed Tray Paper Type ]| | Separate i

Auto Cycle

9576} 100% ||
E g Skip Feed

3
4_
1. Machine status or messages 4. [Job Reset] key
Displays current machine condition. Press to cancel the current job.

2. Number of prints made. See p.57 “Canceling a Print Job”

3. [End Printing] key

Press to cancel the current master making
or printing. See p.7 “Selecting the Cycle
Setting Mode”




Getting Started

+ Key list

[OK] Acknowledges a selected function or entered values, and then returns
to the previous display

[Cancel] Deletes a selected function or entered values, and then returns to the
previous display

[APrev.], [V Next] Moves to the previous page or the next page when all functions cannot
be displayed on one page.

[OK] [Yes] Closes displayed messages.

[Clear] Clears entered values and does not change the settings.

[Exit] Returns to the previous display.

Printer Settings

It is possible to change the paper size and cycle setting mode on the Printer Set-
tings menu.

Selecting the Online Print Paper Size

This machine automatically detects the paper size, however, there are cases
where the machine cannot detect the size of the paper. In these cases, follow the
procedure below and manually make the desired settings.

0 press the [ Printer Settings ]key on the printer.
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ﬂ Press [Tray Paper Size: Paper Feed Tray].
B Select the paper size, and then press [OK].

ﬂlmportant
O Select a size that is bigger than the contents to be printed. If the contents
are bigger than the paper size, it will cause the roller to get dirty.

ﬂ Press [Exit].



Control Panel

Selecting the Cycle Setting Mode

You can select an operation mode for master making and printing online.
® Auto Cycle

Master Print Master Print

[+ A+ B|»

el
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Master making and printing are completed continuously.

If printing is suspended using the [ Clear/Stop] on the control panel, it stops in
the print mode.

In this case, it is not possible to switch to the master making mode unless
printing is completed.

To resume master making from the next page, press the [End Printing] on the
display and terminate the printing operation.

® Original Page Cycle

Master Print Master Print

S
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Operations stop briefly after both master making and printing of each page
are performed.

After printing, if further data remains waiting for master making, the printer
switches back to master making mode. Press the [ Start] key when the printer
has stopped to resume master making from the next page. If no further data
remains, the printer will end the operation.

&P Note

O If further data remains waiting for master making, the printer switches to
master making mode after making each print. However, if you need addi-
tional printing of the preceding original, switch the machine to print mode,
and then press the [Start] key.



Getting Started

® Master Cycle

Master Print Master Print
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There is a belief pause between completion of the master and beginning the
print.

The machine briefly stops after master making, but does not pause between
printing and master making of the following page. When master making is
concluded, the machine pauses again before switching to print mode.

Press the [Start] on the control panel to begin printing.

& Note

O Since it switches to the print mode when master making concludes, to pro-
ceed to the master making of the next page without printing the master
making page, press the [End Printing] on the display and conclude the print
mode.

@ Master/Print Cycle

Master Print Master Print

S
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Operation stops briefly after each master making and print.

After printing, if further data remains waiting for master making, the printer
will switch back to the master making mode.

Press the [ Start] on the control panel to start printing. It switches to the master
making mode with printing in the concluded state.

Press the [Start] key when the printer has stopped to resume master making
from the next page. If no further data remains, the printer will end the operation.

& Note

O If further data remains waiting for master making, the printer will switch
to the master making mode at the end of the print. However, if you need
additional printing still need to execute additional print after the end of the

preceding print, switch the machine to the print mode, and then press the
[ Start] key.



Control Panel

ﬂ Press the [Printer Settings ] key.
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ﬂ Press the [Cycle Setting] .
B Select the Cycle Setting Mode, and then press [OK].
O press the [Exit].
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2. Preparing to Print

This section gives instructions for connecting the printer and computer, config-
uring the printer, and installing software.

% When operating the printer with a USB or a parallel connection

¢ Connect the printer and computer using a USB or a parallel connection.

p Reference

For details about connection using the USB, see Preparations for Use as a
Printer.

For details about connection using the parallel cable, see p.12 “Connect-
ing the Machine”.

¢ Install a printer driver from the CD-ROM labeled "Printer Drivers and Util-
ities".
A Reference
For details, see p.24 “Installing the Software”.

% When operating the printer under a network environment

¢ Configure the network using the machine's control panel.

p Reference
For details, see p.17 “User Tools Menu (System Settings)”.

For details about connection using Ethernet, see Preparations for Use as a
Printer.

For information about connection using wireless LAN, see p.12 “Con-
necting the Machine”.

e Install a printer driver and other utilities from the CD-ROM labeled "Print-
er Drivers and Utilities".

/O Reference
For details, see p.24 “Installing the Software”.

4 Note

O “Network environment” describes a situation where the printer is connected
to a computer via wireless LAN.

O The IEEE 1284 parallel board for parallel connection and the IEEE 802.11b in-
terface unit for wireless LAN connection cannot be used at the same time.

O Wireless LAN and parallel connection are optional functions.

11
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Preparing to Print

Connecting the Machine

When the IEEE 1284 When the IEEE 802.11b
interface board (optional) interface unit (optional)
is installed. is installed.

1. USB interface port

Use a USB interface cable to connect the
printer to the host computer.

2. Ethernet interface port

Use a network interface cable to connect
the printer to a network.

3. Parallel interface port

Connector for the parallel interface cable
used when connecting to a computer.

4. 1EEE 802.11b (wireless LAN) in-
terface port

Use to install the IEEE 802.11b interface
unit for wireless LAN connection to the
network.

/O Reference
For details about connection using
USB and Ethernet, see Preparations
for Use as a Printer.

AJK2048



Connecting the Machine

Requirements

Before using this printer, make sure all environmental and electrical require-
ments are met. Connect the printer to the host computer using the parallel inter-
face port, network interface unit, or both.

Make sure all interface cables, connectors, and electrical outlets necessary to at-
tach the printer to the host computer or network are at hand.

iﬁklmportant
O The interface cable is not supplied. It is your responsibility to prepare the in-
terface cable appropriate for the computer that you are using.

Using the Parallel interface Cable

Connect the printer to the host computer using a parallel interface cable compli-
ant with IEEE 1284 (available separately).

Follow these steps to connect the printer to the host computer.

iﬁklmportant

O Before connecting an interface cable between the printer and a computer,
make sure that the printer is not operating, and then turn off the main power
switches of the printer and the computer.

ﬂ Attach the parallel interface cable to the parallel interface connector of the
printer, and then secure the parallel interface cable.

T
—

J»)@ﬂ it
i
| /

ﬂ Attach the other end of the parallel interface cable to the port of the compu-
ter. Secure the interface cable.

ACV014S
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Preparing to Print

Using IEEE 802.11b (Wireless LAN)

Setting IEEE 802.11b (Wireless LAN)

m |[EEE 802.11b (wireless LAN) setup procedure

<When the IEEE 802.11b Board is installed>
Select [IEEE 802.11b] on [Interface]
||
( Select the communication mode
(ad hoc mode ) (802.11 ad hoc mode) ( infrastructure mode )
u | | ||
(Set the Channel ) ( Set the SSID )
<When setting the code>
C Set the \iVEP key )
C Enable/Disable the code )
| |
( Apply the settings )
( Confirm the connection )

v

& Note

O Select [802.11 Ad hoc] as the communication mode when connecting Windows
XP as a wireless LAN client using Windows XP standard driver or utilities, or
when not using the infrastructure mode.



Connecting the Machine

Confirming the Connection

ﬂ Make sure the LED of the IEEE 802.11b card is lit.

% When using in infrastructure mode

—_

|Lr

1. If [LAN Type] on the [Interface Set-
tings]/[Network] screen is not set to
[IEEE 802.11b], this LED does not
light, even if the main power is on.

(T |
\

ZGDH600J

2. If the printer is connected proper-
ly to the network, the LED will be
green in infrastructure mode. If the
LED is blinking, the printer is
searching for devices.

+« When using in ad hoc mode/802.11 ad hoc mode

—_

o Tom
-\

|Lf

1. If the IEEE 802.11b card is work-
ing, the LED is orange.

ZGDH600J

2. If the printer is connected proper-
ly to the network, the LED is green
in ad hoc mode or 802.11 ad hoc
mode. If the LED is blinking, the
printer is searching for devices. The
LED will light after a few seconds.

15
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Preparing to Print

ﬂ Print the configuration page to verify settings.

A Reference
For details, see p.93 “Printing the configuration page”.

Checking the machine's radio wave status

When using the machine's infrastructure mode, you can check its radio wave
status on the control panel.

& Note
O To check the radio wave status, press [IEEE 802.11b] under [LAN Type] on the
[Network] screen.

ﬂ Press the [User Tools] key.

ég 5=
=
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ﬂ Press [System Settings].
B Press [Interface Settings].
O press [IEEE 802.11b].

B press [Wireless LAN Signal].
The machine's radio wave status appears.

E After checking radio wave status, press [Exit].

ﬂ Press the [User Tools] key to return to the User Tools menu.



User Tools Menu (System Settings)

User Tools Menu (System Settings)

This section describes the network settings you can change with User Tools (Sys-
tem Settings). Make settings according to functions you want to use and the in-
terface to be connected.

ﬂlmportant

O These settings should be made by the systems administrator, or after consult-
ing with the systems administrator.

% Viewing the Information Displayed in the List
@ These items must be set to use the function. Be sure to set them before at-
tempting to use the corresponding function.
For details about settings, see p.20 “Settings You Can Change with User
Tools”
O These items must be set if required.

For details about settings, see "Settings You Can Change with User Tools",
Network Guide.

Interface Settings
Interface Settings

Ethernet Interface Set- IP Address [
tings/Network Gateway Address O

See p.20 “Interface
Settings/Network”. | NW Frame Type O
Effective Protocol ™ o
Ethernet Speed O
LAN Type ™ [
IEEE 802.11b (wire- Interface Set- IP Address o
less LAN) tings/Network Gateway Address o)

See p.20 “Interface
Settings/Network”. | Effective Protocol [
Interface Set- NW Frame Type O

. %

tings/IEEE 802.11b Ethernet Speed 5

See p.22 “Interface
Settings /IEEE LAN Type “ L
802.11b" Communication Mode L
SSID Setting O
Channel @)
WEP (Encryption) Setting O
Wireless LAN Signal O
O

Transmission Speed

17



Preparing to Print

"I Check [Active] is selected for TCP/IP.

"2 Appears when the IEEE 802.11b interface unit is installed.
If Ethernet and IEEE 802.11b (wireless LAN) are both connected to the printer, the
selected interface has priority.

Network Configuration

Any change you make with User Tools remains in effect even if the main power
switch or operation switch is turned off, or if the [ Clear Modes ] key is pressed.

Configuring the network using the control panel

& Note

O Operations for System Settings are different from normal operations. After
using User Tools, press the [User Tools] key to exit.

O If the key operator code has been set, the key operator code entry screen ap-
pears. Enter the code, and then press the [OK] key. For details about the key
operator code, see Operating Instructions.

ﬂ Press the [User Tools] key.

s <~
=
@ |s
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g Press [System Settings].

B Press [Interface Settings].

ﬂ Select the setting you want to change, and then press [OK].
B Change the setting, and then press [OK].

& Note

O To cancel changes made to settings and return to the System Settings
menu, press [Cancel].

E Press [Exit].
ﬂ Press the [User Tools] key.

& Note
O You can also exit by pressing [EXit] on the User Tools main menu.

18



User Tools Menu (System Settings)

Configuring the network using other utilities

In addition to the control panel, Web Image Monitor and SmartDeviceMonitor
for Admin can also be used for configuring the network. The following table
shows available settings:

& Note
O Olndicates printer settings can be changed.

O - Indicates the setting cannot be changed from that device.

Web Tm- | 020
Name on the control panel age Mon- | . telnet
itor itor for
Admin
Interface | Network |DHCP O O O
IP Address O O O
Subnet Mask O O O
Gateway Address O O O
NW Auto @] - O
Frame I metlT O - O
Type
Ethernet802.2 O - O
Ethernet802.3 O - O
EthernetSNAP O - O
Active TCP/IP - 01 O
Protocol
NetWare O 0O*? O
SMB O @) O
AppleTalk O O O
Ethernet Speed - - -
LAN Ethernet O - O
Type IEEE 802.11b O - O
IEEE Comm. Mode O - O
802.11b Channel O - O
Trans. Speed - - O
SSID O - O
WEP Encryption O - O
WEP Key O - O

1 You can make the TCP/IP settings if SmartDeviceMonitor for Admin is communi-
cating with the printer using IPX/SPX.

2" You can make the IPX/SPX settings if SmartDeviceMonitor for Admin is communi-
cating with the printer using TCP/IP.

19
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Preparing to Print

Settings You Can Change with User Tools

Interface Settings/Network

R
4

R
**

2
**

IP Address
Before using this machine in the network environment, you must configure
the IP address and subnet mask.

¢ Auto-Obtain (DHCP)

* Specify
When you select [Specify], enter the [IP Address]and [Sub-net Mask] as
XXX XXX XXXXXX (“X” indicates a number).

e P Address: 011.022.033.044
e Sub-net Mask: 000.000.000.000

& Note
O Default: Auto-Obtain (DHCP)

O When you select [Specify], be sure not to set the same [IP Address] as that of
another machines on the network.

O The physical address (MAC address) also appears.

Gateway Address
A gateway is a connection or interchange point between two networks. Con-
figure the gateway address for the router or host computer used as a gateway.

¢ Gateway Address:000.000.000.000

& Note
3O Default: 000.000.000.000

Effective Protocol
Select the protocol to use in the network.

e TCP/IP:Effective/Invalid

e NetWare:Effective/Invalid

e SMB:Effective/Invalid

* AppleTalk:Effective/Invalid

4 Note

O Default: TCP/IP: Effective, NetWare: Effective, SMB: Effective, AppleTalk: Effec-
tive



User Tools Menu (System Settings)

+« NW Frame Type
Select the frame type when you use NetWare.

e Auto Select

e EthernetIl

e Ethernet 802.2
e Ethernet 802.3
e Ethernet SNAP

& Note
O Default: Auto Select

« Ethernet Speed
Set the access speed for networks.
Select a speed that matches your network environment. [Auto Select] should
usually be selected.

¢ Auto Select
¢ 100Mbps Fixed
* 10Mbps Fixed

& Note
O Default: Auto Select

% LAN Type
When you have installed the optional IEEE 802.11b interface unit, select inter-
face, IEEE 802.11b (wireless LAN) or Ethernet.

e FEthernet

e JEEE 802.11b

& Note

O Default: Ethernet

O Appears when the optional IEEE 802.11b interface unit is installed.

O If Ethernet and IEEE 802.11b (wireless LAN) are both connected to the ma-
chine, the selected interface takes precedence.

2]
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Interface Settings/IEEE 802.11b

5] Preparation

You must install the IEEE 802.11b interface unit into the printer.

4 Note

0

2
**

R
**

Be sure to make all settings.

Communication Mode
Specifies the communication mode of the wireless LAN.

e 802.11 Ad hoc
e Ad hoc

e Infrastructure

& Note
O Default: 802.11 Ad hoc

SSID Setting

Specifies SSID to distinguish the access point in infrastructure mode or 802.11
ad hoc mode.

® Limitation

O The characters that can be used are ASCII 0x20-0x7e (32 bytes).

& Note

O Default: blank (ASSID)

O If blank is specified in 802.11b ad hoc mode or ad hoc mode, “ASSID” ap-
pears.

Channel
Specifies a channel when you select 802.11b ad hoc mode or ad hoc mode.

& Note
O Default: 11

O The following channels are available:
* Metric version: 1-13
* Inch version: 1-11



User Tools Menu (System Settings)

< WEP (Encryption) Setting
Specifies the encryption of the IEEE 802.11b (wireless LAN). If this is set to
[Active], you must enter the WEDP key.

e PWEP
e Active
¢ Inactive

e P»Encryption
10 alphanumeric characters must be entered for 64 bit, 26 characters for 128
bit.

¢ Note
O Default: Inactive

% Wireless LAN Signal

Shows the radio wave conditions of the access point connected in infrastruc-
ture mode.

& Note
O Radio wave status is displayed when you press [Wireless LAN Signal].

% Transmission Speed
Specifies the communication speed of the IEEE 802.11b (wireless LAN).

e Auto

¢ 11Mbps Fixed
* 5.5Mbps Fixed
¢ 2Mbps Fixed
* 1Mbps Fixed

& Note
O Default: Auto

 Return to Defaults
You can return the IEEE 802.11b (wireless LAN) settings to their defaults.
* No
* Yes

23
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Installing the Software

This manual assumes you are familiar with general Windows procedures and
practices. If you are not, see the operating instructions that come with Windows
for details.

The procedure for installing the printer driver depends on the connection with
the computer. With a parallel or Ethernet connection, Quick Install is also avail-
able. With a wireless LAN connection, check the printer and computer are com-
municating properly and then install the printer driver by following the
procedure used for an Ethernet connection.

* For details about the parallel /network connection, see p.25 “Quick Install” or
p-27 “Installing RPCS Printer Driver”.

* For details about the USB connection, see p.44 “Installing the Printer Driver
Using USB”.

Auto Run

Inserting the CD-ROM into the CD-ROM drive starts the installer automatically.
The installer helps you install the printer drivers and software easily.

& Note

O If “plug and play” starts, click [Cancel] in [New Hardware Found], [Device Drive]
or [Found New Hardware Wizard] dialog box, and then insert the CD-ROM. The
[New Hardware Found], [Device Driver Wizard] or [Found New Hardware Wizard] dia-

log box appears depending on the system version of the Windows
95/98/Me/2000/XP, Windows Server 2003, or Windows NT 4.0.

O Auto Run might not work automatically with certain operating system set-
tings. If this happens, launch "Setup.exe", located on the CD-ROM root direc-
tory.

O If you want to cancel Auto Run, hold down the [ SHIFT] key (if your operating
system is Windows 2000/ XP or Windows Server 2003, hold down the left
[SHIFT] key) while inserting the CD-ROM. Keep the [SHIFT] key held down
until the computer has finished accessing the CD-ROM.

e Limitation

O If your operating system is Windows 2000/XP, Windows Server 2003, or
Windows NT 4.0, installing software using Auto Run requires Administrator
permission. When you install software using Auto Run, log on using an ac-
count that has Administrators permission.
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The following table shows the printer drivers and software that can be installed
using Auto Run:

Auto Run ™
Quick Install Add Printer and
Network connection | Parallel connection Utility Wizard
with TCP/IP
RPCS Printer Driver O O
PostScript3 Printer
) O
Driver
SmartDeviceMonitor o
for Admin
SmartDeviceMonitor
for Client © o

1 Available operating systems are: Windows 95/98/Me/2000/XP, Windows Server
2003, and Windows NT 4.0. Auto Run is unavailable with Macintosh.

Quick Install

Auto Run will start the installer automatically when you insert the CD-ROM
into the CD-ROM drive. By selecting Quick Install, you can easily install the
RPCS printer driver. SmartDeviceMonitor for Client can also be installed pro-
vided the printer and computer are connected via the network.

5] Preparation
Before starting installation, close all documents and applications.

® Limitation

O The following conditions are required:
e Windows 95/98/Me/2000/XP, Windows Server 2003, or Windows NT 4.0
For network connections:
* The printer must be connected to the network using an Ethernet cable.
e TCP/IP protocol must be configured.
¢ The IP address must be assigned to both printer and computer.

e The IEEE 802.11b interface unit is installed and the connection is properly
made.

For parallel connections:
¢ The printer must be connected to the computer using a parallel cable.
e Bidirectional transmission must be enabled.
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ﬁlmportant
O If your system is Windows NT 4.0, we recommend that you upgrade the Win-

dows NT 4.0 operating system to Service Pack 4 or later before installing the
RPCS printer driver. Contact your Windows retailer for details about latest
versions.

¢ Note

O When the printer is connected to the computer using the USB interface, Quick
Install cannot be used. See p.44 “Installing the Printer Driver Using USB”.

ﬂ Quit all applications running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

B Select a language for the interface, and then click [OK].

The following languages are available: Deutsch (German), English (English),
Espanol (Spanish), Francais (French), Italiano (Italian), Nederlands (Dutch),
Russian (Russian)

The default interface language is English.
O click [Quick Install].

The software license agreement appears in the [License Agreement] dialog box.

B After reading through the agreement, click [l accept the agreement.] to agree,
and then click [Next].

B Click the printer model you are using when the [Select Printer] dialog box ap-
pears.

& Note

O For TCP/IP network connection, select the printer whose IP address is dis-
played in the [Connect To] column.

O For parallel connection, select the printer whose printer port is displayed
in the [Connect To] column.

ﬂ Click [Install].



Installing the Software

B Follow the instructions on the screen.

A message prompting you to restart your computer may appear. To complete
installation, restart your computer.

ﬂlmportant
O If the printer has options installed, you should make settings for them us-

ing the printer driver. See p.32 “Setting Up Options - RPCS”.

& Note
O If you want to change the printer name, follow the procedure below:

e Windows 95/98/Me/2000, and Windows NT 4.0
On the [Start] menu, point to [Settings], and then click [Printers]. The
[Printers] window appears. Right-click the printer icon, and then click
[Rename].

¢ Windows XP Professional and Windows Server 2003
On the [Start] menu, click [Printers and Faxes]. The [Printers and Faxes]
window appears. Right-click the printer icon, and then click [Rename].

e Windows XP Home Edition
On the [Start] menu, click[Control Panel]. Click [Printers and Other Hard-
ware], and then click [Printers and Faxes]. The [Printers and Faxes] window
appears. Right-click the printer icon, and then click [Rename].

Installing RPCS Printer Driver

This section gives basic instructions for installing the RPCS printer driver with-
out using Quick Install. Follow the procedures below, as appropriate.

A Reference
See p.25 “Quick Install” to install the RPCS printer driver using Quick Install.

® Limitation

O If your operating system is Windows 2000/XP, Windows Server 2003, or
Windows NT 4.0, installing a printer driver using Auto Run requires Admin-
istrator permission. When you install a printer driver using Auto Run, log on
using an account that has Administrator permission.

O SmartDeviceMonitor for Client, included on the CD-ROM, must be installed.

iﬁklmportant

O If your operating system is Windows NT 4.0, we recommend that you up-
grade the Windows NT 4.0 operating system to Service Pack 4 or later before
installing the printer drivers. Contact your Windows retailer for details about
latest versions.
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& Note

O If you want to share the printer on a Windows 2000/XP, Windows Server
2003, or Windows NT 4.0 platform, use the [Sharing] tab in the [Printer Proper-
ties] dialog box to specify the additional driver (alternate driver). For details,
see the operating instructions that come with Windows 2000/XP, Windows
Server 2003, or Windows NT 4.0.

O When prompted for the additional driver (alternate driver) location, select the
following folders on the CD-ROM:

e Windows 95/98/Me
RPCS: \DRIVERS\RPCS\WIN9X_ME\ (Language) \DISK1\

e Windows 2000/XP and Windows Server 2003
RPCS: \DRIVERS\RPCS\WIN2K_ XP\ (Language) \DISK1\

e Windows NT 4.0
RPCS: \DRIVERS\RPCS\ NT4\(Language)\DISK1\

ﬂ Quit all applications running.

B insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

B Select a language for the interface, and then click [OK].

The following languages are available: Deutsch (German), English (English),
Espanol (Spanish), Francais (French), Italiano (Italian), Nederlands (Dutch),
Russian (Russian)

The default interface language is English.

E] Click [RPCS Printer Driver].
The software license agreement appears in the [License Agreement] dialog box.

B After reading through the agreement, click [l accept the agreement.] to agree,
and then click [Next].

E Select the printer drivers you want to install when the [Select Program] dia-
log box appears, and then click [Next].

ﬂ Select the model of the printer you are using.

To change the printer name, change it in the [Change settings for 'Printer Name']
box.

B Double-click the printer name to display the printer settings.
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g Add the new port from SmartDeviceMonitor.

Selecting the port type

@ Click [Port:], and then click [Add].
@ Click [SmartDeviceMonitor], and then click [OK].
© Select the printer you want to use.

“ TCP/IP

@ Click [TCP/IP], and then click [&Search].
Available machines will be listed.

@ Select the printer you want to use, and then click [OK].

& Note
O Machines that respond to an IP broadcast from the computer will be
displayed. To print to a printer not listed here, click [Specify Address -
TCP/IP], and then enter the IP address or host name.

O Part of the printer's IP address is used for the port name. Under Win-
dows 95/98/Me, avoid using an address that is partially similar to
one already in use. For example , if “192.168.0.2” is already used,
“192.168.0.2xx” cannot be used. Similarly, if “192.168.0.20” is already
used, “192.168.0.2” cannot be used.

+ NetBEUI

@ Click [NetBEUI], and then click [&Search].
A list of machines that can be used with NetBEUI appears.

® Select the printer you want to use, and then click [OK].

& Note
O NetBEUI cannot be used under Windows XP or Windows Server 2003.

O Machines that respond to a broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address -
TCP/IP], and then enter the NetBEUI address. Confirm the NetBEUI
address on the network is on the configuration page. The NetBEUI
address appears as “\\RNPxxxx\xxx” on the configuration page.
Enter the machine's network path name in the form of "%%Compu-
ter name\Share name". Do not enter "\\" but "%%" as head charac-
ters.

O You cannot print to machines beyond routers.
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< IPP
@ Click [IPP].
The [IPP Setting] dialog box appears.
® To specify the IP address of the printer, enter "http://machine's-ip-
address/printer" or "ipp://machine's-ip-address/printer" in the
[Printer URL] box.
(Example: IP address is 192.168.15.16)

http://192.168.15.16/printer
ipp://192.168.15.16/printer

® If necessary, enter the names to distinguish the printer in the [IPP Port
Name] box. Enter a different name to those of any existing port name.
If you do not do this, the address entered in the [Printer URL] box will
be set as the IPP port name.

@ If a proxy server and IPP user name are used, click [&Detailed Settings],
and then configure the necessary settings.

& Note
m For details, see SmartDeviceMonitor for Client Help.
® Click [OK].

[E] Make sure the location for the selected printer appears after [Port:].
m Configure the user code and default printer as necessary.

< User Code
User codes are eight digit codes that allow you to keep track of printing done
under each code. To use this feature, the network administrator should assign
user codes and inform users of them before they install the printer driver.
Use the following procedures to enter a user code for registration:

* For the PostScript3 printer driver, enter the user code on the [Job Log]
tab in the printer properties dialog box.

¢ For the RPCS printer driver, click the [Printer Configuration...] button on the
[Print Settings] tab in the [Printer Properties] dialog box. Click the [User Code...]
button. A dialog box appears. Enter the user code in the dialog box.

& Note

O When using the RPCS printer driver on Windows 95/98 /Me, the user code
cannot be changed once it is entered. To change an entered user code, un-
install the printer driver, reinstall it, and then enter a new user code.

A Reference
For details, see Operating Instructions.

+ Default Printer
Select the [Default Printer] check box to set the printer as the default printer.

[B Click [Continue] to start printer driver installation.

[B Follow the instructions on the screen.



Installing the Software

Changing port settings

Follow these steps to change SmartDeviceMonitor for Client settings, such as the
proxy server settings or IPP URL.

& Note
O There are no port settings for NetBEUI.

ﬂ In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

4 Note

O Under Windows XP and Windows Server 2003, click the icon of the printer
you want to use in the [Printers and Faxes] window.

ﬂ Click the [Details] tab, and then click [Port Settings].
The [Port Settings] dialog box appears.

& Note

O Under Windows 2000/XP, Windows Server 2003, and Windows NT 4.0,
click the [Ports] tab, and then click [Configure Port...]. The [Port Configuration:]
dialog box appears.

e For TCP/IP, you can configure Timeout Settings.

@ Note

O If you cannot select the items on the [Recovery/Parallel Printing] tab, follow
the procedure below.

@ Click [Cancel] to close the [Port Settings] dialog box.

® Start SmartDeviceMonitor for Client, and then right-click the Smart-
DeviceMonitor for Client icon on the taskbar.

® Click [Extended Features Settings], and then select the [&Set Recov-
ery/Parallel Printing for each port] check box.

@ Click [OK] to close the [Extended Features Settings] dialog box.
¢ For IPP, you can configure IPP User Settings, Proxy Settings and Timeout
Settings.

& Note
O For details, see SmartDeviceMonitor for Client Help.
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Setting Up Options - RPCS

If the printer has options installed, you should set the options using the printer
driver.

? Limitation

O Under Windows 2000/ XP and Windows Server 2003, changing printer set-
tings requires Manage Printers permission. Members of the Administrators
and Power Users groups have Manage Printers permission by default. When
you set up options, log on using an account that has Manage Printers permis-
sion.

O Under Windows NT 4.0, changing printer settings requires Full Control per-
mission. Members of the Administrators, Server Operators, Print Operators,
and Power Users groups have Full Control permission by default. When you
set up options, log on using an account that has Full Control permission.

When setting up options, you should access the [Printer Properties] dialog box
from Windows. You cannot set up options by accessing the [Printer Properties] di-
alog box from an application.

RPCS printer driver

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

& Note

3 Under Windows XP Professional or Windows Server 2003, click the [Print-
ers and Faxes] window on the [Start] menu.

3 Under Windows XP Home Edition, access the [Printers and Faxes] window
by clicking the[Start] button on the taskbar, click [Control Panel], click [Print-
ers and Other Hardware], and then click [Printers and Faxes].

g Click the icon of the printer you want to use.
E] on the [File] menu, click [Properties].
The printer properties dialog box appears.

& Note

O If the following message appears “Configure installed accessories in the
[Accessories] tab of [Printer Configuration...], which will open next.”, click
[OK], and then proceed to step B.

ﬂ Click the [Change Accessories...] tab.

@ Note

3 Under Windows 95/98/Me, click [Printer Configuration...] on the [Print Set-
tings] tab, and then click [Change Accessories...].

32 B Select the options installed in the [Select printer options:] list.
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O cick [ox.
ﬂ Click [OK], and then close the [Printer Properties] dialog box.

Installing the PostScript3 printer driver

This section gives basic instructions for installing the PostScript3 printer driver.
Actual procedures may differ depending on the operating system. Follow the
procedures below, as appropriate.

p Reference

To use the PostScript3 printer driver, the PostScript3 board must be installed
on the printer. For details, see PostScript3.

Windows 95/98/Me - Installing the PostScript3 printer driver

ﬂ Close all running applications.

ﬂ Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

B Select a language for the interface, and then click [OK].

The following languages are available: Deutsch (German), English (English),
Espanol (Spanish), Francais (French), Italiano (Italian), Nederlands (Dutch),
Russian (Russian)

The default interface language is English.

& Note
O The printer driver with the selected language will be installed.

O When Russian is selected, an English version is installed.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B crick pNext).

B Click [Local Printer], and then click [Next].
A dialog box for selecting the printer appears.

ﬂ Select the model of the printer you are using, and then click [Next].
8 In the [Available ports:] box, click [Printer Port], and then click [Next].
g Change the name of the printer if you want to, and then click [Next].

& Note
O Click [Yes] if you want to set the printer as the default printer.
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[E] Follow the instructions on the screen.

Windows 95/98/Me - Setting up options

If the printer has options installed, you should make settings for them using the
printer driver.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

g Click the icon of the printer you want to use.

E] on the [File] menu, click [Properties].
The printer properties dialog box appears.

O Click the [Device Options] tab.
B Select the options you have installed in the [Installable options] area.

(3 ciick [ok).

Windows 2000/XP and Windows Server 2003 - Installing the PostScript3 printer driver

? Limitation

O Installing a printer driver requires Administrator permission. When you in-
stall a printer driver, log on using an account that has Administrator permis-
sion.

& Note

O If you want to share the printer on a Windows 2000/XP or Windows Server
2003 platform, use the [Sharing] tab in the [Printer Properties] dialog box to spec-
ify the additional driver (alternate driver). For details, see the operating in-
structions that come with Windows 2000/ XP and Windows Server 2003.

O When prompted for the additional driver (alternate driver) location, select the
following folders on the CD-ROM:

* Windows 95/98/Me: \DRIVERS\PS\WIN9X_ME\ (Language) \DISK1\
¢ Windows NT 4.0: \DRIVERS\PS\NT4\ (Language) \DISK1\

ﬂ Close all running applications.

ﬂ Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.
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B Select a language for the interface, and then click [OK].

The following languages are available: Deutsch (German), English (English),
Espanol (Spanish), Francais (French), Italiano (Italian), Nederlands (Dutch),
Russian (Russian)

The default interface language is English.

& Note
O The printer driver with the selected language will be installed.

O When Russian is selected, an English version is installed.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next).
[3 click [Local Printer], and then click [Nexi].

@ Note

O Under Windows XP or Windows Server 2003, click [Local printer attached to
this computer], and then click [Next].

A dialog box for selecting the printer port appears.

ﬂ Select the check box of the port you want to use, and then click [Next].
A dialog box for selecting the printer appears.

8 Select the model of the printer you are using, and then click [Next].

g Change the name of the printer if you want to, and then click [Next].

& Note
O Click [Yes] if you want to set the printer as the default printer.

[m Select whether or not you want to share the printer, and then click [Next].

p Reference

See Network Guide for information about setting up and using the printer
in a network environment.

ﬂ] Follow the instructions on the screen.
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Windows 2000/XP and Windows Server 2003 - Setting up options

If the printer has options installed, you should make settings for them using the

printer driver.

? Limitation

O Changing the printer settings requires Manage Printers permission. Members
of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you set up options, log on using an account that has
Manage Printers permission.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

@ Note

O Under Windows XP Professional or Windows Server 2003, click the [Print-
ers and Faxes] window on the [Start] menu.

O Under Windows XP Home Edition, access the [Printers and Faxes] window
by clicking the [Start] button on the taskbar, click [Control Panel], [Printers
and Other Hardware], and then click [Printers and Faxes].

g Click the icon of the printer you want to use.

E] On the [File] meny, click [Properties].
The printer properties dialog box appears.

O Click the [Device Settings] tab.
B Select the options you have installed under [Installable Options].
(3 ciick [ok).

Windows NT 4.0 - Installing the PostScript3 printer driver

® Limitation

O Installing a printer driver requires Administrator permission. When you in-
stall a printer driver, log on using an account that has Administrator permis-
sion.

ﬁlmportant

O The CD-ROM containing Windows NT Server operating system version 4.0,
or the Windows NT Workstation operating system is required to install the
printer driver.

O We recommend that you upgrade Windows NT 4.0 operating system to Serv-
ice Pack 6 or later before installing the printer driver. Contact your Windows
retailer for details about latest versions.
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& Note

O If you want to share the printer on a Windows NT 4.0 platform, use the [Shar-
ing] tab in the [Printer Properties] dialog box to specify the additional driver (al-
ternate driver). For details, see the operating instructions that come with
Windows NT 4.0.

O When prompted for the additional driver (alternate driver) location, select the
following folders on the CD-ROM:

* Windows 95/98/Me: \DRIVERS\PS\WIN9X_ME\ (Language) \DISK1\

ﬂ Close all running applications.

ﬂ Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

B Select a language for the interface, and then click [OK].

The following languages are available: Deutsch (German), English (English),
Espanol (Spanish), Francais (French), Italiano (Italian), Nederlands (Dutch),
Russian (Russian)

The default interface language is English.

& Note
O The printer driver with the selected language will be installed.

O When Russian is selected, an English version is installed.

E] Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B Confirm that the [My Computer] option is selected, and then click [Next].
A dialog box for selecting the printer port appears.

B Select the check box of the port you want to use, and then click [Next].
A dialog box for selecting the printer appears.

ﬂ Select the model of the printer you are using, and then click [Next].
B Change the name of the printer if you want to, and then click [Next].

& Note
O Click [Yes] if you want to set the printer as the default printer.

g Select whether or not you want to share the printer, and then click [Next].

/O Reference

See Network Guide for information about setting up and using the printer
in a network environment.

[[D Follow the instructions on the screen.
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Windows NT 4.0 - Setting up options

If the printer has options installed, you should make settings for them using the

printer driver.

? Limitation

O Changing printer settings requires Manage Printers permission. Members of
the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you set up options, log on using an account that has
Manage Printers permission.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.
ﬂ Click the icon of the printer you want to use.

E] On the [File] menu, click [Properties].
The [Printer Properties] dialog box appears.

ﬂ Click the [Device Settings] tab.
B Select the options you have installed under [Installable Options].
(3 ciick [ok).

’@1Bidirectionql transmission

When bidirectional transmission is enabled, information such as paper size and
feed orientation is automatically sent to the computer. You can also check print-
er status from your computer.

* Bidirectional transmission is supported under Windows 95/98/Me/2000/XP,
Windows Server 2003, and Windows NT 4.0.

* When bidirectional transmission is running, printer status and information
can be viewed by opening the printer driver screen.

To support bidirectional transmission, the following conditions are required:

% When connecting with USB 2.0

* The port on the USB 2.0 interface and the USB port on the computer are
connected using a USB interface cable (Windows 2000/ XP, Windows Serv-
er 2003).

&P Note

3 Under Windows 2000/ XP or Windows Server 2003, [Enable bidirectional
support] must be selected, and [Enable printer pooling] must not be selected
on the [Ports] tab in RPCS printer driver.
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+«+ When connecting with the network
¢ The printer must be set to bidirectional transmission.

¢ SmartDeviceMonitor for Client included on the CD-ROM must be in-
stalled.

One of the following conditions must also be satisfied as well as the two re-

quirements mentioned above:

¢ The port for SmartDeviceMonitor and TCP/IP must be used.

¢ The standard TCP/IP port is used without changing the port name (Win-
dows 2000/ XP, Windows Server 2003).

¢ The IP address specified in the Microsoft TCP/IP Print is used (Windows
NT 4.0).

* The IP address is included in port name, if using IPP protocol.

& Note
3 Under Windows 95/98/Me, [Enable bi-directional support for this printer] must
be selected in [Spool Settings] on the [Details] tab in RPCS printer driver.

O Under Windows 2000/ XP, Windows Server 2003, or Windows NT 4.0, [En-
able bidirectional support] must be selected, and [Enable printer pooling] must
not be selected on the [Ports] tab in RPCS printer driver.

< When connecting with a parallel cable
* The computer must support bidirectional transmission.
* The printer must be set to bidirectional transmission.
* The printer parallel port and computer parallel port are connected using a
parallel interface cable that supports bidirectional transmission.

& Note
O Under Windows 95/98/Me, [Enable bi-directional support for this printer] must
be selected in [Spool Settings] on the [Details] tab in RPCS printer driver.

O Under Windows 2000/ XP, Windows Server 2003, or Windows NT 4.0, [En-
able bidirectional support] must be selected, and [Enable printer pooling] must
not be selected on the [Ports] tab in RPCS printer driver.
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Mac OS - Installing the PostScript3 printer driver and Utilities

It is necessary to install a printer driver and a PPD file to print from a Macintosh.

Follow this procedure to install a printer driver and a PPD file on Macintosh run-
ning OS 8.6 or later versions up to 9.2, and Mac OS X Classic mode.

& Note
O For installation under Mac OS X (v10.1.x), see p.42 “Mac OS X - Installing the
PostScript3 printer driver”.

ﬂ Insert the CD-ROM into the CD-ROM drive.

ﬂ Double-click the CD-ROM icon.

B Double-click the [Mac 0S] folder.

O Double-click the [PS Driver] folder.

B Double-click the folder of the language you use.

B Open [Disk 1], and then double-click the installer icon.
The PostScript3 printer driver installer window appears.

ﬂ Follow the instructions on the screen.

B Double-click [Extensions] in [System Folder].

ﬂ Double-click [Printer Descriptions].

[E] Double-click the CD-ROM icon on the desktop.

ﬂ] Double-click the [Printer Descriptions] folder in the [Mac OS] folder.

[B Double-click [Disk 1] in the folder of the language you use.

[B Drag the PPD file into [Printer Descriptions] in [Extensions] in [System Folder].

ﬂ] Restart the Macintosh.
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Setting up the PPD file

5] Preparation
Make sure that the printer is connected to an AppleTalk network before per-
forming the following procedure:

ﬂ On the Apple menu, click [Chooser].
B Click the [Adobe PS] icon.

B In the [Select a PostScript Printer:] list, click the name of the printer you want
to use.

O click [Setup].
B ciick [select PPD....
B Click the printer description file you want to use, and then click [Select].

U crick [ok).

The PPD file is set up, and the [Adobe PS] icon appears at the left of the printer
name in the list. Next, follow the procedure on p.41 “Setting up options” to
make the option settings, or close the [Chooser] dialog box.

Setting up options

ﬂ On the Apple menu, click [Chooser].
B Click the [Adobe PS] icon.

B In the [Select a PostScript Printer:] list, click the name of the printer you want
to use, and then click [Setup...].

ﬂ Click [Configure].
A list of options appears.

B Select the option you want to set up, and then select the appropriate setting
for it.

& Note
O If the option you want to set up is not displayed, the PPD file might not be
set up correctly. Check the name of the PPD file shown in the dialog box.

(3 ciick [ok).
The list of options closes.

H crick [ox).
8 Close the [Chooser] dialog box.
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Mac OS X - Installing the PostScript3 printer driver

It is necessary to install a PPD file to print from a Macintosh. Follow the proce-
dures to install a PPD file on Macintosh running Mac OS X.

Printer driver is included in Mac OS. When printing under Mac OS X v10.1.x, use
the printer driver included in Mac OS.

E Preparation
You need an administrator name and a password (phrase). For details, con-
sult your administrator.

ﬂ Insert the CD-ROM into the CD-ROM drive.
ﬂ Double-click the CD-ROM icon.
E) Double-click the [Mac 0S X] folder.

ﬂ Double-click the [Mac OSX PPD Installer] folder, and then double-click the in-
staller icon.

B Follow the instructions on screen.

Setting up the PPD file

ﬂ Run [Print Center].
B crick [add].

& Note
O Select [AppleTalk] in the first pop-up menu.

O If the zone has been set, select the zone in the second pop-up menu.

B Select the PPD file for the model you are using from the [Printer Model:] pop-
up menu.

O click [Add].
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Selecting PPD files when using USB

Itis necessary to select a PPD file in order to be able to use printers with USB con-
nection. Make the setting as described below.

I] Run [Print Center].
ﬂ Click [Add Printer].
B Select [USB] in the first pop-up menu.

ﬂ Select a printer and select the printer brand name of the printer in use from
the [Printer Model:] pop-up menu.

& Note
O If using MAC OS X 10.1.x, a list of printer models is displayed on the [Print-
er Model:] pop-up menu. Select the printer model in use and proceed to step

a.
B Select the connected printer model from the list of printers and Click [Add].
[ Close the Printer List and close [Print Center].

Setting up options

? Limitation

O You can make settings for all printer features, even if the necessary option is
not installed due to Mac OS X Native mode limitations. Check which options
are installed in the printer before you print.
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Installing the Printer Driver Using USB

This section gives basic instructions for installing printer drivers using USB. The
printer drivers can be installed from the CD-ROM that comes with this printer.

E Preparation

Make sure that all other applications are closed and the computer is not print-
ing before installation.

Windows 2000/XP and Windows Server 2003 - Installing the printer driver using USB

? Limitation

O Installing a printer driver requires the Administrators permission. When you
install a printer driver, log on using an account that has Administrator per-
mission.

When the USB interface cable is used for the first time, the [Found New Hardware

Wizard] dialog box appears.

If the printer driver is already installed, the “plug and play” is displayed, and

the printer with its port directed to the USB interface cable is added to the [Print-

ers] ! folder.

& Note

O Under Windows XP, even if the printer driver has already been installed,
[Found New Hardware Wizard] may start when connecting the printer and the
computer with the USB interface cable for the first time. If this happens, in-
stall the printer driver by following the procedure below:

ﬂ Install the printer driver by referring to the instructions for installation.

& Note
O Each printer driver is stored in the following folders on the CD-ROM:
¢ RPCS: \DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1
¢ PostScript 3: \DRIVERS\PS\WIN2K_XP\(Language)\DISK1
When installation is complete, the printer with its port directed to “USB00On”

£ 7

appears in the [Printers] ! folder. (“n” is the number of printers connected.)
1" Under Windows XP, the folder is [Printers and Faxes].
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Macintosh - Creating a desktop printer icon

When you connect the printer and your computer using USB 2.0, create a Desk-
top Printer icon.

? Limitation

O Under Mac OS X Native mode, printing is disabled when connected to the
printer using USB.

ﬂ Double-click [Desktop Printer Utility] in the [AdobePS Components] folder.

g Select [AdobePS] in [With:] and [Printer (USB)] in [Create Desktop], and then
click [OK].

B Click [Change] in [USB Printer Selection].

ﬂ Select the model of the printer you are using in [Select a USB Printer:], and
then click [OK].

B click [Auto Setup] in [PostScript™ Printer Description (PPD) File].
(3 ciick [Create].

ﬂ Enter the printer name, and then click [Save].
The printer icon appears on the desktop.

8 Close the Desktop Printer Utility.

Installing DeskTopBinder Lite- SmartDeviceMonitor for Client

b4 Limitation

O If your operating system is Windows 2000/XP, Windows Server 2003, or
Windows NT 4.0, installation using Auto Run requires Administrator per-
mission. To install a printer driver using Auto Run, you must log on using an
account that has Administrator permission.

ﬂ Close all running applications.

ﬂ Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

B Select a language for the interface, and then click [OK].
The default interface language is English.

ﬂ Click [DeskTopBinder - SmartDeviceMonitor for Client].

B A massage telling you to close all other applications appears.
Confirm that all applications are closed, and then click [Next].
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E The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [Yes]

ﬂ Click [Full install] or [Custom Install].
[Full install] installs all required applications.
[Custom Install] installs selected applications.

8 Follow the instructions on the display, and then click [Next].

Installing SmartDeviceMonitor for Admin

® Limitation

O If your operating system is Windows 2000/XP, Windows Server 2003, or
Windows NT 4.0, installation using Auto Run requires Administrator per-
mission. To install a printer driver using Auto Run, log on using an account
that has Administrator permission.

ﬂ Close all running applications.

Fd 1nsert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

B Select a language for the interface, and then click [OK].
The default interface language is English.

ﬂ Click [SmartDeviceMonitor for Admin].

B A message telling you to close all other applications appears.
Confirm that all applications are closed, and then click [Next].

E The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [Yes]

ﬂ Follow the instructions on the display and click [Next].
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Using Adobe PageMaker Version 6.0, 6.5, or 7.0

If you use the printer under Windows 95/98/Me/2000/XP, Windows Server
2003, or Windows NT 4.0 with Adobe PageMaker, you need to copy the PPD file
to the PageMaker folder.

The PPD file is the file with the extension “.ppd” in the folder “DRIV-
ERS\PS\WIN9X_MEN\ (Language) \DISK1\"” on the CD-ROM. g

The [WIN9X_ME] folder, inside the [PS] folder, is for Windows 95/98 /Me. Use the
folder at a level appropriate for the operating system you are currently using.

The third folder, “(Language)” may be renamed with an appropriate language
name.

Copy the file with extension “.ppd” to the PageMaker folder.

* For PageMaker 6.0 default installation
The directory is “C:\PM6\RSRC\PPD4".

* For PageMaker 6.5 default installation
The directory is “C:\PM65\RSRC\USENGLISH\PPD4".
“USENGLISH” may vary depending on your language selection.

* For PageMaker 7.0 default installation
The directory is “C:\PM7\RSRC\USENGLISH\PPD4".
“USENGLISH” may vary depending on your language selection.

& Note

O When using PageMaker, optional features that can be selected by the printer
driver will not be active. The following procedure describes how to activate
the optional printer features.

@® On the [File] menu, click [Print].
The [Print Document] dialog box appears.

® Make the necessary settings in the [Features] box.
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Software and Utilities Included on the CD-ROM

The CD-ROM labeled “Printer Drivers and Utilities” is mainly used for printer
functions. In this manual, “CD-ROM” refers to the “Printer Drivers and Utili-
ties” CD-ROM, unless specified otherwise.

Printer Drivers

Printing requires installation of a printer driver for your operating system. The
following drivers are included on the CD-ROM labeled “Printer Drivers and
Utilities” that comes with the printer option of this printer.

Printer Language RPCS PostScript3
Windows 95 ™ V NEE
Windows 98 \ \ 13
Windows Me ™ \ NEE
Windows 2000 ™ \ NE!
Windows XP ™ \ N
Windows Server 2003 " N NEET
Windows NT 4.0 8 et NEEE
Mac OS ™ |13
Mac OS X 10 NEE

1 Microsoft Windows 95 operating system

"2 Microsoft Windows 98 operating system

3 Microsoft Windows Millennium Edition

“ Microsoft Windows 2000 Server

Microsoft Windows 2000 Professional

Microsoft Windows XP Professional

Microsoft Windows XP Home Edition

6 Microsoft Windows Server 2003 Standard Edition

Microsoft Windows Server 2003 Enterprise Edition

Microsoft Windows Server 2003 Web Edition

Cluster and Terminal Service are not supported.

Microsoft Windows NT Server operating system version 4.0, Microsoft Windows NT

Workstation operating system version 4.0 in a computer using x86 processors.

" Versions 8.6 to 9.2 of the Mac OS (Mac OS X Classic mode is supported.)

10 Mac OS X 10.1 or later (Native mode)

"Il Requires Service Pack 4 or later.

"12 Requires Service Pack 6 or later.

"13 The Adobe PostScript3 printer drivers and PostScript Printer Description (PPD,) files
are included on the CD-ROM labeled “Printer Drivers and Ultilities”.

"14 The PostScript Printer Description (PPD) files are included on the CD-ROM labeled
“Printer Drivers and Utilities”.

15 The Adobe PostScript Printer Description (PPD) installer is included on the CD-
ROM labeled “Printer Drivers and Utilities”.

*5

*7
*8



Software and Utilities Included on the CD-ROM

< RPCS printer driver
The RPCS printer drivers are included on the CD-ROM labeled "Printer Driv-
ers and Utilities" This printer driver allows the computer to communicate
with the printer via a printer language. The preset type user interface is pro-
vided in addition to the usual one.
See p.27 “Installing RPCS Printer Driver” .

« Adobe PostScript3 printer drivers and PPD files
The Adobe PostScript3 printer driver and the PPD files are included on the
CD-ROM labeled "Printer Drivers and Utilities" This printer driver allows the
computer to communicate with the printer via a printer language. The PPD
files allow the printer driver to enable printer specific functions.
See p.33 “Installing the PostScript3 printer driver” .

Software and Utilities

< SmartDeviceMonitor for Admin
This utility is for the system administrator to manage network printers.

AP Reference
For details, see SmartDeviceMonitor for Admin online Help.

< SmartDeviceMonitor for Client
This utility is for users to manage their own print status on the network.

pe Reference
For details, see SmartDeviceMonitor for Client online Help.

+ Printer Utility for Mac
This utility allows users to download and manage a variety of fonts as well as
manage printers.

/O Reference

For details, see PostScript3 which is provided as a PDF file on the CD-ROM
labeled “Operating Instructions”.

ﬂlmportant

O Software and utilities must be uninstalled before installing newer versions of
Windows. Reinstall software and utilities after upgrading Windows.
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3. Setting Up the Printer Driver

and Canceling a Print Job

Accessing Printer Properties

Windows 95/98/Me - Accessing Printer Properties

Changing default settings

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer whose default you want to change.

B On the [File] menu, click [Properties].
The [Printer Properties] dialog box appears.

ﬂ Make the settings you require, and then click [OK].

& Note
O With some applications, printer driver settings are not used, and the appli-
cation's own settings are applied.

Making settings from an application

To make settings for a specific application, open the printer properties dialog
box from that application. The following example describes how to make set-
tings in WordPad for Windows 95/98/Me.

& Note

O Actual procedures for opening the [Printer Properties] dialog box may vary de-
pending on the application. For details, see operating instructions for the ap-
plication you are using.

O Any setting you make in the following procedure is valid for the current ap-
plication only:

ﬂ On the [File] menu, click [Print].
The [Print] dialog box appears.

g In the [Name] list, select the printer you want to use, and then click [Proper-
ties...].

The [Printer Properties] dialog box appears.
B Make the settings you require, and then click [OK].

ﬂ Click [OK] to start printing. .
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Windows 2000/XP and Windows Server 2003 - Accessing Printer
Properties

Changing default settings - Printer properties

? Limitation

O Changing printer settings requires Manage Printers permission. Members of
Administrators and Power Users groups have Manage Printers permission
by default. When you set up options, log on using an account that has Manage
Printers permission.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

& Note

O Under Windows XP Professional and Windows Server 2003, open the
[Printers and Faxes] window on the [Start] menu.

O Under Windows XP Home Edition, open the [Printers and Faxes] window
by clicking [Control Panel] from the [Start] button on the taskbar, click [Print-
ers and Other Hardware], and then click [Printers and Faxes].

ﬂ Click the icon of the printer whose default you want to change.

E] On the [File] menu, click [Properties].
The [Printer Properties] dialog box appears.

ﬂ Make the settings you require, and then click [OK].

& Note

O Normally you do not have to change the “Form to Tray Assignment” set-
tings on the [Device Settings] tab in the PostScript3 printer driver.

O Settings you make here are used as default for all applications.
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Changing default settings - Printing preferences properties

? Limitation

O Changing printer settings requires Manage Printers permission. Members of
the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you set up options, log on using an account that has
Manage Printers permission.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

@ Note

O Under Windows XP Professional and Windows Server 2003, open the
[Printers and Faxes] window on the [Start] menu.

O Under Windows XP Home Edition, open the [Printers and Faxes] window
by clicking [Control Panel] from the [Start] button on the taskbar, click [Print-
ers and Other Hardware], and then click [Printers and Faxes].

g Click the icon of the printer whose default you want to change.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the settings you require, and then click [OK].

& Note
O Settings you make here are used as default for all applications.

Making settings from an application

To make settings for a specific application, open the [Print] dialog box from that
application. The following example describes how to make settings in WordPad
for Windows 2000/ XP and Windows Server 2003.

4 Note

O Actual procedures for opening the [Print] dialog box vary depending on the
application. For details, see the operating instructions that come with the ap-
plication you are using.

O Any setting you make in the following procedure is valid for the current ap-
plication only.

& on the [File] menu, click [Print..].
The [Print] dialog box appears.
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ﬂ In the [Select Printer] list, select the printer you want to use, and then click
the tab for which you want to change print settings.

& Note

O Under Windows XP and Windows Server 2003, click [Preferences] to open
the [Printing Preferences] dialog box.

B Make the settings you require.

ﬂ Click [Print] to start printing.

Under Windows XP and Windows Server 2003, click [OK], and then click
[Print] to start printing.

Windows NT 4.0 - Accessing Printer Properties

Changing default settings - Printer properties

® Limitation

O Changing printer settings requires Full Control access permission. Members
of Administrators, Server Operators, Print Operators, and Power Users
groups have Full Control permission by default. When you change printer
settings, you must log on using an account that has Full Control permission.

on the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.
ﬂ Click the icon of the printer whose default you want to change.

E] On the [File] menu, click [Properties].
The [Printer Properties] dialog box appears.

ﬂ Make the settings you require, and then click [OK].

& Note

O Normally you do not have to change the “Form to Tray Assignment” set-
tings on the [Device Settings] tab in the PostScript3 printer driver.

O Settings you make here are used as default for all applications.



Accessing Printer Properties

Changing the default settings - Default document properties

? Limitation

O Changing printer settings requires Full Control access permission. Members
of the Administrators, Server Operators, Print Operators, and Power Users
groups have Full Control permission by default. When you set up options, log
on using an account that has Full Control permission.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer whose default you want to change.

B On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.

ﬂ Make the settings you require, and then click [OK].

& Note
O Settings you make here are used as default for all applications.

Making settings from an application

To make settings for a specific application, open the [Printer Properties] dialog box
from that application. The following example describes how to make settings in
WordPad for Windows NT 4.0.

4 Note

O Actual procedures for opening the [Printer Properties] dialog box vary depend-
ing on the application. For details, see the operating instructions that come
with the application you are using.

O Any setting you make in the following procedure is valid for the current ap-
plication only.

ﬂ On the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ In the [Name] list, select the printer you want to use, and then click [Proper-
ties].

The [Printer Properties] dialog box appears.
8 Make the settings you require, and then click [OK].
ﬂ Click [OK] to start printing.
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Macintosh - Setting Up for Printing

Making paper settings from an application

ﬂ Open the file you want to print.

H On the [File] menu, click [Page Setup..].
The [AdobePS Page Setup] dialog box appears.

B Make sure the printer you want to use is shown in the [Printer:] box.

& Note
3 Under Mac OS X, this is called [Format for:].

O If the printer is not shown in the [Printer:] box, use the pop-up menu to dis-
play a list of available machines.

p Reference

The actual appearance of Page Setup depends on the application you are
using. See the operating instructions that come with the Macintosh for de-
tails.

ﬂ In the [Paper:] box, select the paper size.

& Note
3 Under Mac OS X, this is called [Paper Size:].

B Make the settings you require, and then click [OK].

Setting up for printing from an application

ﬂ Open the file you want to print.

H On the [File] menu, click [Print:].
The [Printer Features] dialog box appears.

B Make sure the printer is selected in the [Printer:] box.

ﬂ Make the settings you require, and then click [Print] to start printing.



Canceling a Print Job

Canceling a Print Job

Canceling from a computer

Windows

ﬂ Double-click the printer icon on the Windows taskbar.

A window appears, showing all the print jobs that are currently queuing to
be printed. Check the current status of the job you want to cancel.

g Select the name of the job you want to cancel.
B On the [Document] menu, click [Cancel Printing].

& Note
O You can also open the print job queue window by double-clicking the
printer icon in the [Printer] window.

Macintosh

ﬂ Double-click the printer icon on the desktop.

A window appears, showing all the print jobs that are currently queuing to
be printed. Check the current status of the job you want to cancel.

& Note
O Under Mac OS X, start Print Center.

ﬂ Select the name of the job you want to cancel.
B Click the pause icon, and then click the trash icon.

& Note
O Under Mac OS X, Click [Hold], and then click [Delete].
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Canceling on the control panel

Canceling before the printer starts Master Making

The print jobs of all pages can be canceled before the printer starts Master Mak-
ing.

ﬂ Press [Job Reset] on the machine's display panel.

Canceling after the printer has started Master Making

In order to cancel the print job after Master Making has started, press “Job Reset”
or “End Printing” on the display panel.

% Pressing “Job Reset” while Master Making is in progress
If “Job Reset” is pressed while Master Making is processing a particular page,
the print job will be cancelled beginning from the next page.

& Note

O If the Master Making is processing the last page of a print job, the print job
cannot be canceled

% Pressing “Job Reset” while printing
If “Job Reset” is pressed when a particular page is being printed, the job will
be canceled beginning from the next page.

& Note

O If the last page is being printed, the next print job will be canceled. If there
are no print jobs in queue, the “Job Reset” button will not function.

% Pressing “End Printing” while printing queue is on pause
When a print job is paused, the next master making cannot begin until print-
ing is completed. If there are any pages remaining when printing is paused,
press the “End Printing” to cancel the remaining pages and master making
for the next print job can begin.
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4. Various Types of Printing

Windows 95/98/Me - Various Types of Printing

This section introduces several printing examples from Windows 95/98 and Me.

A Reference
For details, see the operating instructions that come with the respective appli-
cation.

Duplex Printing

Prints on both sides of the sheet.

? Limitation
O Duplex printing is possible on the following paper sizes only: A4[J), B5 JIS[)
and 8!/," x 11”%.

ﬂ Display the data to be printed.

B on the [File] menu, click [Print..].
The [Print] dialog box appears.

B From [Name:], select the printer.

!] Click [Properties].
The [Properties] dialog box appears.

B In the [Custom Setting name:] menu on the [Print Settings] tab, select the [Du-
plex].

E On the [Print Settings] tab, click [Add/Change Custom Settings...].
The [Add/Change Custom Settings...] dialog box appears.

ﬂ Click [Duplex/Booklet], and then select the opening side.

B click [save).
The screen returns to the [Properties] dialog box.

B crick [ok).
The screen returns to the [Print] dialog box.

[ crick [oK].
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Storing the Print File

Use this function to store a file in the machine, and then print it from the com-
puter or the machine's control panel later.

? Limitation

O If data from PostScript3 printer driver is stored in the machine using [Store
File], when printing from the machine, it is possible that the data will not print
in the intended direction. For details, see PostScript3.

1] Display the data to be printed.

H On the [File] menu, click [Print..].
The [Print] dialog box appears.

B From [Name:], select the printer.

ﬂ Click [Properties].
The [Properties] dialog box appears.

B In the [Job type:] menu on the [Print Settings] tab, select [Store File].

B If you want to set [User name:], [File name:]and [Password:], click [Details...].
The [Details...] dialog box appears.

ﬂ Set [User name:], [File name:], and [Password:].

B click [ok).
The screen returns to the [Properties] dialog box.

B cick [ox.
The screen returns to the [Print] dialog box.

0 click [ok).
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Printing on custom sized paper

Printing on custom sized paper

ﬁlmportant
O Be sure to load paper in the paper feed tray.

ﬂ Display the data to be printed.

g On the [File] menu, click [Print...].
The [Print] dialog box appears.

B From [Name:], select the printer.

ﬂ Click [Properties].
The [Properties] dialog box appears.

B In the [Original size:] menu on the [Print Settings] tab, click [Custom paper size...].
The [Custom Paper Sizes] dialog box appears.
E Enter the paper size in [Short edge:] and [Long edge:].

& Note
O Specify [Measurement Unit...] if required.

ﬂ Select [Place as portrait] or [Place as landscape] according to the paper orienta-
tion.

B click [ok).
The screen returns to the [Properties] dialog box.

B crick fok1.
The screen returns to the [Print] dialog box.

[ crick [oK].
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Printing on paper with an undetectable size

This machine automatically detects the paper size, however, there are cases
where the machine cannot detect the size of the paper. In these cases, follow the
procedure below and manually make the desired settings.

iﬁklmportant
O Be sure to load paper in the paper feed tray.

& Note

O If you make these settings frequently, it is convenient to define a default size
by selecting [Tray Paper Size: Paper Feed Tray] in Online Print menu on the con-
trol panel.

0 press the [ Printer Settings ]key on the printer.
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8 Press [Tray Paper Size: Paper Feed Tray].
B Select the paper size, and then press [OK].

ﬁlmportant
O Select a size that is bigger than the contents to be printed. If the contents
are bigger than the paper size, it will cause the roller to get dirty.

ﬂ Select the paper size on the computer's printer driver.

ﬂlmportant
O Select the same paper size selected in the [Tray Paper Size: Paper Feed Tray]
setting on the machine.

B Print from the computer.
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When envelopes cannot be fed

Envelopes cannot be fed in well because the seal may get caught. In that case,
you can rotate and print the image by 180 degrees using the rotate function in
the printer driver.

The following chart shows how the image is rotated.

Paper Fged Di- Original Image Rotate: Off Rotate: 180°
& &
rection
Portrait - < <= >
Short Edge
Feed
Landscape = A <= V
Portrait - A - V
Long Edge Feed
Landscape - < = >
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ﬂ Rotate the envelopes 180 degrees and place them in the paper feed tray.

4*—
4*—

GRENVE1E

*Paper feed direction
ﬂ On the printer driver’s [Misc.] tab, select [Rotate by 180 degrees].

B click [ok).
The screen returns to the [Print] dialog box.

ﬂ Click [OK] to start printing.



Windows 2000/XP and Windows Server 2003 - Various Types of Printing

Windows 2000/XP and Windows Server 2003 -
Various Types of Printing

This section introduces several printing examples from Windows 2000/XP and
Windows Server 2003.

/O Reference

For Details, see the operating instructions that come with your respective ap-
plication.

Duplex Printing

Prints on both sides of the sheet.

? Limitation
[ Duplex Printing is possible on the following paper sizes only: A4[J, B5 JIS[)
and 81/," x 11"%.

ﬂ Display the data to be printed.

H on the [File] menu, click [Print..].
The [Print] dialog box appears.

B From [Select Printer], select the printer.

ﬂ Click [Preferences].
The [Printing Preferences] dialog box appears.

B In the [Custom Setting name:] menu on the [Print Settings] tab, select the [Du-
plex].

B On the [Print Settings] tab, click [Add/Change Custom Settings...].
The [Add/Change Custom Settings...] dialog box appears.

ﬂ Click [Duplex/Booklet] and select the open side.

B click (save].
The screen returns to the [Printing Preferences] dialog box.

B cick [ox.
The screen returns to the [Print] dialog box.

0 click [Print.
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Storing the Print File

Use this function to store a file in the machine, and then print it from the com-
puter or the machine's control panel later.

? Limitation

O If data from PostScript3 printer driver is stored in the machine using [Store
File], when printing from the machine, it is possible that the data will not print
in the intended direction. For details, see PostScript3.

1] Display the data to be printed.

H On the [File] menu, click [Print..].
The [Print] dialog box appears.

B From [Select Printer], select the printer.

ﬂ Click [Preferences].
The [Printing Preferences] dialog box appears.

B In the [Job type:] menu on the [Print Settings] tab, select [Store File].

B If you want to set [User name:], [File name:] and [Password:], click [Details...].
The [Details...] dialog box appears.

ﬂ Set [User name:], [File name:], and [Password:].

B click [ok).
The screen returns to the [Printing Preferences] dialog box.

B cick [ox.
The screen returns to the [Print] dialog box.

0 Click [Print].
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Printing on custom sized paper

It is possible to make settings for custom sized paper.

ﬁlmportant
O Be sure to load paper in the paper feed tray.

ﬂ Display the data to be printed.

g On the [File] menu, click [Print...].
The [Print] dialog box appears.

B From [Select Printer], select the printer.

ﬂ Click [Properties].
The [Properties] dialog box appears.

B In the [Original size:] menu on the [Print Settings] tab, click [Custom paper size...].
The [Custom Paper Sizes] dialog box appears.
E Enter the paper size in [Short edge:] and [Long edge:].

& Note
O Specify [Measurement Unit...] if required.

ﬂ Select [Place as portrait] or [Place as landscape] according to the paper orienta-
tion.

B click [ok).
The screen returns to the [Properties] dialog box appears.

B crick fok1.
The screen returns to the [Print] dialog box.

M click Print].
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Printing on paper with an undetectable size

This machine automatically detects the paper size, however, there are cases
where the machine cannot detect the size of the paper. In these cases, follow the
procedure below and manually make the desired settings.

iﬁklmportant
O Be sure to load paper in the paper feed tray.

& Note

O If you make these settings frequently, it is convenient to define a default size
by selecting [Tray Paper Size: Paper Feed Tray] in the Online Print menu on the
control panel.

0 press the [ Printer Settings ]key on the printer.
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8 Press [Tray Paper Size: Paper Feed Tray].
B Select the paper size, and then press [OK].

ﬁlmportant
O Select a size that is bigger than the contents to be printed. If the contents
are bigger than the paper size, it will cause the roller to get dirty.

ﬂ Select the paper size on the computer's printer driver.

ﬂlmportant
O Select the same paper size selected in the [Tray Paper Size: Paper Feed Tray]
setting on the machine.

B Print from the computer.
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When envelopes cannot be fed

Envelopes cannot be fed in well because the seal may get caught. In that case,
you can rotate and print the image by 180 degrees using the rotate function in
the printer driver. The following chart shows how the image is rotated.

Paper Feed Di- | 1y 504 al Image Rotate: Off Rotate: 180°
8 8
rection
Portrait o < - >
Short Edge
Feed
Landscape - A = V
Portrait - A - V
Long Edge Feed
Landscape - < = >
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ﬂ Rotate the envelopes 180 degrees and place them in the paper feed tray.

4*—
4*—

GRENVE1E

*Paper feed direction
ﬂ On the printer driver’s [Misc.] tab, select [Rotate by 180 degrees].

B click [ok).
The screen returns to the [Print] dialog box.

ﬂ Click [Print] to start printing.
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Windows NT 4.0 - Various Types of Printing

This section introduces several printing examples from Windows NT 4.0.

/O Reference
For details, see the operating instructions that come with your respective ap-
plication regarding details on settings.

Duplex Printing

Prints on both sides of the sheet.

? Limitation
[ Duplex Printing is possible on the following paper sizes only: A4[J, B5 JIS[)
and 8'/," x 11"%.

ﬂ Display the data to be printed.

H 0n the [File] menu, click [Print..].
The [Print] dialog box appears.

B From [Name:], select the printer.

ﬂ Click [Properties].
The [Properties] dialog box appears.

B In the [Custom Setting name:] menu.

B On the [Print Settings] tab, click [Add/Change Custom Settings...].
The [Add/Change Custom Settings...] dialog box appears.

ﬂ Click [Duplex/Booklet] and select the opening side.

B click (save].
The screen returns to the [Properties] dialog box.

B cick [ox.
The screen returns to the [Print] dialog box.

[ crick [ok).
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Storing the Print File

Use this function to store a file in the machine, and then print it from the com-
puter or the machine's control panel later.

? Limitation

O If data from PostScript3 printer driver is stored in the machine using [Store
File], when printing from the machine, it is possible that the data will not print
in the intended direction. For details, see PostScript3.

1] Display the data to be printed.

H On the [File] menu, click [Print..].
The [Print] dialog box appears.

B From [Name:], select the printer.

ﬂ Click [Properties].
The [Properties] dialog box appears.

B In the [Job type:] menu on the [Print Settings] tab, select [Store File].

B If you want to set [User name:], [File name:],and [Password:], click [Details...].
The [Details...] dialog box appears.

ﬂ Set [User name:], [File name:], and [Password:].

B click [ok).
The screen returns to the [Properties] dialog box.

B cick [ox.
The screen returns to the [Print] dialog box.

0 click [ok).
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Printing on custom sized paper

It is possible to make settings for custom sized paper.

ﬁlmportant
O Be sure to load paper in the paper feed tray.

ﬂ Display the data to be printed.

g On the [File] menu, click [Print...].
The [Print] dialog box appears.

B From [Name:], select the printer.

ﬂ Click [Properties].
The [Properties] dialog box appears.

B In the [Original size:] menu on the [Print Settings] tab, click [Custom paper size...].
The [Custom Paper Sizes] dialog box appears.
E Enter the paper size in [Long edge:] and [Short edge:].

& Note
O Specify [Measurement Unit...] if required.

ﬂ Select [Place as portrait] or [Place as landscape] according to the paper orienta-
tion.

B click [ok).
The screen returns to the [Properties] dialog box.

B crick fok1.
The screen returns to the [Print] dialog box.

[ crick [oK].
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Printing on paper with an undetectable size

This machine automatically detects the paper size, however, there are cases
where the machine cannot detect the size of the paper. In these cases, follow the
procedure below and manually make the desired settings.

iﬁklmportant
O Be sure to load paper in the paper feed tray.

& Note

O If you make these settings frequently, it is convenient to define a default size
by selecting [Tray Paper Size: Paper Feed Tray] in the Online Print menu on the
control panel.

0 press the [ Printer Settings ]key on the printer.
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8 Press [Tray Paper Size: Paper Feed Tray].
B Select the paper size, and then press [OK].

ﬁlmportant
O Select a size that is bigger than the contents to be printed. If the contents
are bigger than the paper size, it will cause the roller to get dirty.

ﬂ Select the paper size on the computer's printer driver.

ﬂlmportant
O Select the same paper size selected in the [Tray Paper Size: Paper Feed Tray]
setting on the machine.

B Print from the computer.
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When envelopes cannot be fed

Envelopes cannot be fed in well because the seal may get caught. In that case,
you can rotate and print the image by 180 degrees using the rotate function in
the printer driver.

The following chart shows how the image is rotated.

Paper Fged Di- Original Image Rotate: Off Rotate: 180°
& &
rection
Portrait - < <= >
Short Edge
Feed
Landscape = A <= V
Portrait - A - V
Long Edge Feed
Landscape - < = >
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ﬂ Rotate the envelopes 180 degrees and place them in the paper feed tray.

4*—
4*—

GRENVE1E

*Paper feed direction
EI Click [Add/Change Custom Settings...] on the printer driver’s [Print Settings] tab.
B On the printer driver’s [Misc.] tab, select [Rotate by 180 degrees].

O click fok1.
The screen returns to the [Print] dialog box.

B Click [OK] to start printing.



5. Troubleshooting

Error & Status Messages on the Display Panel

Messages/Second messages

Descriptions and Solutions

Ethernet board Error.

An error has occurred in the Ethernet module.

Turn off the main power switch, and back on again. If the mes-
sage appears again, contact your sales or service representative.

Wireless card error.

IEEE 802.11b card was not inserted when the printer was turned
on, or it was pulled out after the printer turned on.

Turn off the printer and check the IEEE 802.11b card is inserted
correctly. Then, turn the printer on again. If the message ap-
pears again, contact your sales or service representative.

Wireless board error.

An error has occurred in the IEEE 802.11b module.

Turn off the main power switch, and back on again. If the mes-
sage appears again, contact your sales or service representative.

Master Processing...

The master is being made.

Memory switch error.

An error has occurred in the memory unit.

Turn off the main power switch, and back on again. If the mes-
sage appears again, contact your sales or service representative.

Optional RAM error. An error has occurred in the SDRAM module.
Turn off the main power switch, and back on again. If the mes-
sage appears again, contact your sales or service representative.
Printing... Data is being printed.

Wait until the job is finished.

Parallel I/F board error.

An error has occurred in the parallel I/F board.

Turn off the main power switch, and back on again. If the mes-
sage appears again, contact your sales or service representative.

DIMM value error. An error has occurred in the PostScript3 bored.
Turn off the main power switch, and back on again. If the mes-
sage appears again, contact your sales or service representative.
HDD board error. An error has occurred in the HDD board.

Turn off the main power switch, and back on again. If the mes-
sage appears again, contact your sales or service representative.

Print is not finished.

Printing is not finished.

Printing has been interrupted. Perform one of the following

procedures:

e Press the [Start] key, and printing will restart. Before the
print amount display reaches 0, press the [ Start] key to print.

* Press [End Printing] , and printing will stop. The interrupted
prints will not be performed.

Ready<Online>

Master Making or print data is on the spool. This is not an error.

Press the [ Start] key to begin master making or printing.
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Messages/Second messages

Descriptions and Solutions

Ready

The Master Making or print data is not in the spool.

This is not an error. The message will change when printing
starts from the computer.

Resetting Job... The data spooled is dumped.
Wait until the job is finished.
Open the Paper Feed Tray. | The paper feed tray is not set correctly.

Set the paper feed tray correctly.

USB interface error.

An error has occurred in the USB interface.

Turn off the main power switch, and back on again. If the mes-
sage appears again, contact your sales or service representative.

Waiting...

Waiting for data from the computer.
Wait until the job is finished.




Printer does not Print

Printer does not Print

Possible Cause

Solutions

Is the power on?

Turn on the printer.

Does the Start key stay
red?

If so, check the error message or warning status on the display and
take the required action.

Are there any error messag-
es on the display panel?

Check the error message, and take the required action.

Is the interface cable prop-
erly connected?

Connect the interface cable properly.

If there are any connectors or screws, make sure that they are fas-
tened securely.

Are you using the correct
interface cable?

Be sure to use the correct one. If the cable is damaged or worn, re-
place it with a new one.

Did you connect the inter-
face cable after turning on
the main switch?

Be sure to connect the interface cable before turning on the main
switch.

Is the specified paper set?

Set the specified paper in the paper feed tray.

Does the Error indicator
stay red?

Check the error message, and take the required action.

Is the Data In indicator
blinking or lit?

If it is not, the data does not reach the printer. Check the printer
cable connection. Also confirm that the printer port settings are
correct.

Can you make a proof
print?

If you cannot print a system configuration list or a PS Font List
from the printer, the printer might be out of order. Contact your
sales or service representative.

Is “Waiting” displayed?

Perform one of the following procedures:
¢ Wait until the job is finished.
¢ Cancel by pressing [Job Reset].

Is the signal status satisfac-
tory when using IEEE
802.11b interface unit in in-
frastructure mode?

To check signal status, press the [UserTools] key, and then select
[System Settings]. On the [Interface Settings], select [IEEE 802.11b],
and then select [Wireless LAN Signal] . If signal quality is poor, re-
move objects that might cause interference.

@ Note

O You can check signal status only when using IEEE 802.11b in-
terface unit in infrastructure mode.

When using IEEE 802.11b
interface unit, is the SSID
correctly set?

Check using the machine's control panel that the SSID is correctly
set.

see “User Tools Menu (System Settings)”, Network Guide.

When using IEEE 802.11b
interface unit, is the access
point correctly set?

Check access point settings when in infrastructure mode. Depend-
ing on the access point, client access may be limited by MAC ad-
dress.

Also, check that there are no problems in transmission between ac-
cess point and wired clients, and between access point and wire-
less clients.
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Possible Cause Solutions

When using IEEE 802.11b | Confirm that the orange LED is lit and the green LED is lit or blink-
interface unit, is the LED | ing during transmission.

on the wireless LAN card
blinking or lit?

mode?

Is the IEEE 802.11b inter- | Turn the main power off and back on. See “Turning On the Pow-
face being used in ad hoc | er”, General Settings Guide.

Otherwise, configure [Network] in [Interface Settings] in [System Set-
tings]. See “Setting Up the Machine on a Network”, Network Guide.

If you cannot solve the problem by taking the preceding actions, contact your
sales or service representative.

& Note

O If the Data In indicator is not blinking or lit, you can check the computer port
settings using the following procedure.

+ If the printer is connected to the computer using the interface cable
OCheck that the printer port setting is correct. For USB, specify USB00(n)
as the printer port setting ( “n” is the number of printers on the network).
OFor a parallel port connection, port LPT1 or LPT2 should be set.

Windows 95/98/Me

@ Click the [Start] button, point to [Settings], and then click [Printers].
® Click the icon of the printer. On the [File] menu, click [Properties].

® Click the [Details] tab.

@ In the [Print to the following port:] list, confirm the correct port is selected.
Windows 2000

@ Click the [Start] button, point to [Settings], and then click [Printers].
@ Click the icon of the printer. On the [File] menu, click [Properties].

® Click the [Ports] tab.

@ In the [Print to the following port(s)] list, confirm the correct port is selected.
Windows XP Professional and Windows Server 2003

@ Click the [Start] button, and then click [Printers and Faxes].

@ Click the icon of the printer. On the [File] menu, click [Properties].

® Click the [Ports] tab.

@ In the [Print to the following port(s)] list, confirm the correct port is se-
lected.

Windows XP Home Edition

@ Click the [Start] button, click [Control Panel], click [Printers and Other
Hardware], and then click [Printers and Faxes].

® Click the icon of the printer. On the [File] menu, click [Properties].
® Click the [Ports] tab.
@ In the [Print to the following port(s)] list, confirm the correct port is selected.



Printer does not Print

e Windows NT 4.0
@ Click the [Start] button, point to [Settings], and then click [Printers].
® Click the icon of the printer. On the [File] menu, click [Properties].
® Click the [Ports] tab.
@ In the [Print to the following port(s)] list, confirm the correct port is selected.

% Network Connection
OContact your network administrator.
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Other Printing Problems

Status

Possible Causes, Descriptions, and Solutions

Multiple pages are fed through
the printer at once.

Remove all paper from the paper feed tray and fan it gently
to get air between the sheets. Then, load it back into the paper
feed tray.

Cannot print in duplex mode

You cannot use thick paper with duplex printing.

Specify one of the following duplex-compatible paper size:
A4[),B5JIS[) and 8'/5" x 11"[J.

Printing of Duplex data has
been canceled.

If different paper sizes are mixed in the data, select A4 [J,B5
JISE) and 8'/5" x 11"[J) from [Fit to paper size]. If using
Postscript3 printer driver, originals with different sizes can-
not be printed in Duplex mode.

A blank page is automatically
printed.

Depending on the application, when printing a document
from Postscript3 printer driver with an odd number of pages
in duplex mode, a blank page might be added automatically.
To avoid this, set [Blank Page Print] to disable in the PS Menu
on the control panel.

The image is printed on the re-
verse side of the paper.

Load paper with the other side facing up.

Paper misfeeds occur frequent-
ly.

Use the recommended paper. Avoid using curled, folded,
wrinkled, perforated or glossy paper.

The display panel error mes-
sage stays on after removing
the misfed paper.

Open the front cover of the printer and then close it.

A print instruction was issued
from the computer, but printing
did not start.

User code management may have been set. Ask the adminis-
trator about valid user codes. To print, the user code must be
entered from the printer driver.

Photo images are coarse.

Some applications reduce print resolution.

Images are cut off or excess is
printed.

You may be using paper smaller than the size selected in the
application. Use the same size paper as that selected in the
application. If you cannot load paper of the correct size, use
the reduction function to reduce the image, and then print.

See the printer driver Help.

Page layout is not as expected.

Print areas differ depending on the printer used. Information
that fits on a single page on one printer may not fit on a single
page of another printer.

Adjust the [Printable area:] setting on the [Printer Configura-
tion...] tab in the RPCS printer driver.

See the printer driver Help.




Other Printing Problems

Status

Possible Causes, Descriptions, and Solutions

It takes a long time to complete
a print job.

Photographs and other data intensive pages take a long time
for the printer to process, simply wait when printing such data.

Changing the following settings with the printer driver may

help speed up printing:

e RPCS
Click [Change User Settings...] on the [Print Quality] tab in the
[Printer Properties] dialog box, and then select the [Fast] val-
ue for [Image processing priority:] on the [Image Adjustments]
tab in the [Change User Settings...] dialog box.

& Note

O Under Windows 2000/ XP and Windows Server 2003,
click [Change User Settings...] on the [Print Quality] tab in
the [Printing Preferences] dialog box, and then select the
[Fast] value for [Image processing priority:] on the [Image
Adjustments] tab in the [Change User Settings...] dialog
box.

O Under Windows NT 4.0, click [Change User Settings...]
on the [Print Quality] tab in the [Document Defaults] dia-
log box, and then select the [Fast] value for [Image
processing priority:]Jon the [Image Adjustments] tab in the
[Change User Settings...] dialog box.

* PostScript3

Select [PostScript (optimize for speed)]for [PostScript output

format:] on the [PostScript] tab in the [Printer Properties] dia-

log box.

& Note

(3 Under Windows 2000/XP and Windows Server 2003,
click [Advanced...] on the [Paper/Quality] tab in the [Print-
ing Preferences] dialog box, and then select [PostScript
output options : optimize for speed] for [PostScript Options]
in the [Advanced...] dialog box.

O Under Windows NT 4.0, click [Advanced...] in the [Doc-
ument Defaults] dialog box, and then select [PostScript
output options : optimize for speed] for [PostScript Options]
in the [Advanced...] dialog box.

See the printer driver Help.

The data is so large or complex that it takes time to process. If
the Data In indicator is blinking, data is being processed.
Simply wait until printing resumes.

It takes too much time to
resume printing.

The data is so large or complex that it takes time to process. If
the Data In indicator is blinking, data is being processed.
Simply wait until printing resumes.

The printer was in Energy Saver mode. It usually takes time
for the machine to return to ready mode. Simply wait until
printing resumes. See Operating Instructions.
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Status

Possible Causes, Descriptions, and Solutions

Images are printed in the
wrong orientation.

The feed orientation you selected and the feed orientation se-
lected in the printer driver's option setup might not be the
same. Set the machine's feed orientation and the printer driv-
er's feed orientation accordingly.

See the printer driver Help.

<Only when using PostScript3
printer driver under Windows>
The data which uses propor-

tional fonts cannot be printed
exactly as viewed on the screen.

e Under Windows 95/98/Me
Select [Substitute printer fonts for True Type Fonts when appli-
cable] in the [Fonts] tab.

¢  Under Windows 2000/ XP and Windows Server 2003
Click [Advanced...] on the [Paper/Quality] tab or on the [Lay-
out] tab to display the [Advanced Options] dialog box. Select
[Download as softfont] in [TrueType Font:] under [Graphic].

e Under Windows NT 4.0
Click the [Advanced] tab on the [Properties] dialog box. Se-
lect [Download as softfont] in [TrueType Font] under [Graph-
ics] .

<Only when using PostScript3
printer driver under Windows>
Combine printing cannot be
done as specified.

<Only when using PostScript3
printer driver under Windows>

Auto Magnification cannot be
done as specified.

Make sure that the same orientation is set, as well as the same
paper size set in the application.

e Under Windows 95/98/Me, check the [Paper] tab.

e Under Windows 2000/ XP and Windows Server 2003,
check the [Layout] tab.

e Under Windows NT 4.0, check the [Page Setup] tab.

If a different size has been set, select the correct paper size
and orientation.

<Only when using PostScript3
printer driver under Windows>

Printing cannot be done even if

the data is being received in a
network environment.

e Windows 95/98/Me
Click [Advanced...] on the [PostScript] tab to display the [Ad-
vanced PostScript Options] dialog box. Make sure to clear
both the [Send CTRL+D after job] check box and the [Send
CTRL+D before job] check box.

e  Windows 2000/ XP and Windows Server 2003
Make sure to select [No] in both [Send CTRL+D Before Each
Job:] and [Send CTRL+D After Each Job:] in the [Device Set-
tings] tab.

e Windows NT 4.0
Make sure to select [No] in both [Send CTRL+D Before Each
Job] and [Send CTRL+D After Each Job] in the [Device Set-
tings] tab.

<Mac OS only>

The printer is not displayed in
the Chooser.

<Mac OS X only>

The printer is not displayed in
the Printer list.

Make sure that the printer and the Macintosh are connected
in the Apple talk environment.

<Macintosh only>

It takes a long time for the [Print]
dialog box to be displayed.

Depending on the processing speed of the Macintosh system,
the dialog box display may take time.




Other Printing Problems

Status

Possible Causes, Descriptions, and Solutions

<Macintosh only>

It takes a long time to print from
the Macintosh G3 or G4 via a
hub.

When the printer is connected to a Macintosh computer
equipped with the G3 or G4 processor via a hub, it may take
a long time to transfer data on a 100BASE-TX from the Mac-
intosh to the printer.

The same page is being master
made many times.

Make sure to clear the [Collate] check box in the [Print] dialog
box of the application.

< Windows 2000/ XP and Windows Server 2003 only >

Even if the check mark is cleared in the [Collated] check box,
master making may be done every time a page is going to be
printed. In this case, make sure to clear the [collated] check
box displayed when selecting [Copy Count] in [Advanced] dia-
log box of the printer driver.

Fine dot patterns are not printed

e RPCS
Change the [Dithering:] setting under the [Image Adjust-
ments] tab in the [Change User Settings] dialog box under
the [Print Quality] tab in the [Printer Properties] dialog box.
* PostScript3

Change the [Dithering:] setting in the [Advanced] dialog box
under the printer driver's [Print Quality] tab.

Solid lines are printed as
broken lines.

In the RPCS printer driver [Change User Settings] dialog box,
change the [Dithering:] setting on the [Image Adjustments] tab.

For details, see the printer driver Help.

Two or more sheets are fed
together.

In the RPCS printer driver [Change User Settings] dialog box,
change the [Dithering:] setting on the [Image Adjustments] tab.

For details, see the printer driver Help.

The set option cannot be
selected in the print menu.

The option may not be set correctly.
e Windows95/98/Me

Set the option correctly in the [Device Options] tab.
¢ Windows 2000/ XP and Windows Server 2003

Set the option correctly in the [Device Settings] tab.
e Windows NT 4.0

Set the option correctly in the [Device Settings] tab.

¢ Mac OS
Set the option configuration correctly in [Chooser] in the
Apple menu.
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Status

Possible Causes, Descriptions, and Solutions

PDF Direct Print is not executed
(PDF file is not printed).

Set the value in [RAM Disk] on the [PS Menu] to 2 MB or more.

A Reference
For details about RAM Disk, see p.96 “PS Menu”.

When printing a PDF with a password set, set the password
of the PDF file using the [Change PDF Password] menu in [Gen-
eral Features] or Web Image Monitor.

/O Reference

For details about [Change PDF Password], see p.92 “General
Features”.

For details about Web Image Monitor, see Help.

PDF files not allowed to be printed by the PDF file security
setting cannot be printed.

As aresult of printing using
PDF Direct Print, characters are
missing or misshapen.

Before printing, embed the font in the PDF file to be printed.

The paper size appears on the
control panel and printing is
not performed with PDF Direct
Print.

When using PDF Direct Print, printing will be performed
only when paper of the size set within the PDF file is loaded.
When a message indicating a paper size appears, either load
paper of the indicated size in the paper tray or perform Form
Feed.

If [Tray Paper Size: Paper Feed Tray] in the online print feature
menu is set to [Auto Detect], printing proceeds even if the size
of the paper loaded in the paper feed tray differs from the
page size of the PDF file.

The printing data is left in the
machine's input buffer.

Do not use NetWare to configure form feed. Form feed is con-
trolled by the printer driver on Windows. If NetWare form
feed is configured, the printer may not print properly.

Follow the procedure below to disable form feed according to
the operating system used:

e Under Windows 95/98/Me, clear the [Form feed] check
box on the [Printer Settings] tab in the printer properties di-
alog box.

e Under Windows 2000/XP, Windows Server 2003, or Win-
dows NT 4.0, clear the [Form feed] check box on the [Net-
Ware Settings] tab in the printer properties dialog box.




Other Printing Problems

& Note

O A PostScript error could mean that the PostScript data is erroneous or that
there is a lack of memory. Some PostScript errors can be avoided if the mem-
ory is expanded. If you still cannot print as expected, consult your sales or
service representative. For information on your nearest sales or service repre-
sentative, consult the store where you purchased this printer.

O The following is the memory assigned for PostScript.

General memory 128 MB (64 + 64 MB, | 192 MB 320 MB
Factory settings) (64 + 128 MB) (64 + 256 MB)
Assigned memory 15.0 MB 27.0 MB 47.0 MB
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Troubleshooting




Though the factory default settings of the printer are suitable for most printing
jobs, “Online Print Features” menu gives you access to a number of settings that
control basic printer operations. The Online Print Features settings you make are
retained even when the printer is turned off.

p Reference

For details about settings other than the Online Print Features, see the Oper-
ating Instructions.

Online Print Features Menu

The following items are listed in the “Online Parameters” menu.
¢ General Features

e List / Test Print

e Host Interface

e PS Menu

¢ Administrator Tools
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Using the Control Panel

Functions in the following table can be selected:

Menu

Function menu

General Features

Hold Data-in

Tray Paper Size: Paper Feed Tray

Custom Paper Size: Paper Feed Tray

Print Size Priority

Cycle Setting

Memory Over Flow

Spool Printing

Change PDF Password

Print Error Report

List / Test Print

Configuration Page

PDF Configuration / Font Page

PS Configuration / Font Page

Host Interface

1/0 Buffer

1/0 Timeout

PS Menu !

Data Format

RAM Disk

Blank Page Print

Administrator Tools

Return to Defaults

"I Appears when the PostScript3 board is installed.




Adjusting Online Print Features

Adjusting Online Print Features

ﬂ Press the [User Tools] key.
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EI Press [Online Print Features].
8 Select the item you want to change, and then press [OK].

ﬂ Make any setting you require, and then press [OK].

P Note

O To change the value entered, press the [ Clear/Stop ] key before pressing the
[OK] key. Then enter the new value.

O Press [Cancel] to return to the previous menu without changing any data.

B press the [User Tools] key to return to the standby display.

& Note

O The settings are not canceled even if the main switch is turned off or the
[Clear Modes ] key is pressed.

O You can also return to the standby display by pressing the [EXxit] key.
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Using the Control Panel

Online Print Features Settings

General Features

< Hold Data- in
You can select online print mode and choose whether the machine accepts or
rejects online print data from the computer.

& Note

O Default: Off

O Set the mode “On” to reject the online print.
O Set the mode “Off” to accept the online print.

% Tray Paper Size: Paper Feed Tray
You can select the size of the paper loaded in the paper feed tray.

& Note
O Default: Auto Detect
O The machine cannot detect the following paper sizes automatically. When

printing on the following sizes, select the desired paper size on “Tray Pa-
per Size: Paper Feed Tray” menu before printing.

e A5[),HLT[), 8K, 16KZ [)

« Custom Paper Size: Paper Feed Tray
You can specify the custom paper size of the paper loaded in the paper feed tray.

& Note
O Default: 210mm x 297mm

+% Print Size Priority
You can choose to specify the paper size on the printer driver or the control panel.

& Note
O Default: Machine Size

% Cycle Setting
You can select the Cycle Setting mode.

& Note
O Default: Auto Cycle

< Memory Overflow
You can specify whether or not to print an error report when a memory over-
flow occurs.

& Note
O Default: Do not Print



Online Print Features Settings

+ Spool Printing
You can select the Spool printing mode.

& Note
O Default: Off

< Change PDF Password
Set the password for the PDF file executing PDF Direct Print.

& Note
O Default: Not Set

+ Print Error Report
You can specify whether or not to print an error report when a RPCS error or
PostScript error occurs.

& Note
O Default: Off

List / Test Print

% Configuration page
You can print the system controller data.

< PDF Configuration Page
You can print the controller’s PDF font list.

% PS Configuration Page
You can print the controller’s PostScript font list.

Printing the configuration page

ﬂ Press the [User Tools] key.
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ﬂ Press [Online Print Features].

E) select [List/ Test Print] .
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Using the Control Panel

ﬂ Press the type of configuration page you want.
Confirmation massage appears.

B press[ves).
The configuration page is printed.

Interpreting the configuration page

System Reference

< Printer ID

Displays the serial number assigned to the board by its manufacturer.

« Firmware Version

¢ System Version
Displays the version number of the system firmware.

* Engine
Displays the version number of the engine.

* Panel Version
Displays the version number of the panel.

« Controller Option
This item(s) appears when the controller option(s) is installed.

% HDD
Displays the capacity of the HDD.

% Printer Language
Displays the version number of the Printer Description Language.

% Options
Displays the optional trays installed.

Paper Input

Displays the settings made under the Print Size menu.

System

Displays the settings made under the System menu.

PS Menu

Displays the settings made under PS Menu.



Online Print Features Settings

PDF Menu

Displays the settings of PDF Resolution.

Host Interface

Displays the settings of I/O Buffer and I/O Timeout.

Network Setup

Displays the settings made under the Interface menu.

When DHCP is active on the network, the actual IP address, subnet mask and
gateway address appear in parentheses on the configuration page.

IEEE 802.11b

Displays the settings of IEEE 802.11b

Interface Information

Displays the interface information.

Host Interface

< 1/0 Buffer
Sets the capacity of the reception buffer.

¢ Note
O Default: 128 KB

+ 1/0 Timeout
Sets the time to enable the interface after data stops being received. When the
time set here is exceeded, the printer will not receive further data via the in-
terface.

i@klmportant

O If the set time is too short, a time out might occur while one data is being
received. As a result, data from another interface might cut in and be print-
ed, or the emulation retrieval might start to replace the emulation before
the data is completely received.

& Note
O Default: 15 seconds
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PS Menu

% Data Format
You can specify the data format for PostScript print jobs.

& Note
O Default: Binary Data

O Under Mac OS X, select “TBCP” when you print with a USB connection.

< RAM Disk
You can select the RAM disk capacity for PostScript.

& Note
O Default: 4 MB

+ Blank Page Print
Select whether or not to print blank pages.

Administrator Tools

% Return to Defaults
You can reset the settings back to their defaults. However, the “IP Address”,
“Network”, and the “Ethernet Speed” settings remain in effect.



/. Appendix

Printing a PDF File Directly

You can send PDF files directly to the printer to print without opening a PDF ap-
plication.

b4 Limitation

O To use this function, the PostScript3 board must be installed on the printer.
O This is possible for genuine Adobe PDF files only.

O Version 1.3, 1.4, and 1.5 PDF files are compatible.

O Transparency and JBIG2 (functions of PDF version 1.4) are not compatible.
O PDF version 1.5 only functions are not compatible.

O When you make the [Layout] setting using the printer driver, be sure to select
[Portrait] or [Landscape] according to the actual orientation of the PDF print
job.

Printing Method

% Using DeskTopBinder Lite/professional
PDF files registered with DeskTopBinder Lite/professional can be sent di-
rectly to the printer for printing.

& Note
O The RPCS printer driver must be installed.

O Use DeskTopBinder Lite on the provided CD-ROM labeled "Document
Management Utility". PDF file direct printing is supported only by Desk-
TopBinder Lite/professional Version 3.1.1.0 or later.

O PDF Direct Print settings can be made from PDF Direct Print properties.
O To print password-protected PDF files, you must do the following:
¢ Enter the PDF password using PDF Direct Print properties.
* On the control panel, select [Change PDF Password] on the [Online Print
Features] in the User Tools menu to set the PDF password.

A Reference
For details, see DeskTopBinder Lite/professional Help.

To check which version of DeskTopBinder Lite/professional you have, see
DeskTopBinder Lite/professional Help or the DeskTopBinder Lite Re-
adme file on the provided CD-ROM labeled "Document Management Util-

ity".
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Appendix

+ Using commands
From Windows, you can print PDF files directly, using commands such as
“ftp” and “Ipr”.

/O Reference

* For details about printing using commands under Windows, see “Print-
ing Files Directly from Windows”, Network Guide.



Specifications

Specifications

This section contains the machine's electrical and hardware specifications, in-
cluding information about its options.

Component

Specifications

Resolution

¢ RPCS
400 dpi

¢ PostScript3
400 dpi

Printing speed

60-135 ppm
(Duplex Printing max 120ppm)

Interface

Standard:

e TUSB 2.0 interface

e Ethernet interface (100BASE-TX/10BASE-T)
Option:

e [EEE 802.11b wireless LAN interface

e IEEE 1284 parallel interface

Network protocol

TCP/IP, IPX/SPX, NetBEUI !, AppleTalk

Printer language

Standard: RPCS
Option: PostScript3

Fonts Standard: Arial
PostScript3 (Option):136 fonts (Type 2:24, Type 14:112)
Memory 128 MB (64 MB + 64 MB)
Operating systems sup- | Windows 95/98/Me/2000/XP
ported by this printer Windows Server 2003
Windows NT 4.0
Mac OS 8.6 to 9.2
Mac OS X

Required network cable

100BASE-TX/10BASE-T unshielded twisted-pair (UTP, Category/
Typeb) cable.

1" To use NetBEUI, use the SmartDeviceMonitor port.
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Options

? Limitation

O Only one optional interface can be installed in the printer at a time. Therefore,
the IEEE 802.11b interface unit and the IEEE 1284 parallel board cannot be in-
stalled concurrently.

IEEE 802.11b I/F Unit Type 1

% Transmission spec:
Based on IEEE 802.11b (wireless LAN)

« Protocol:
TCP/IP, NetBEUI, IPX/SPX, AppleTalk

& Note
O SmartDeviceMonitor and Web Image Monitor are supported.

+ Data transfer speed:

Auto select from below speed
1Mbps, 2Mbps, 5.5Mbps, 11Mbps

+ Frequency range:

¢ Inch version:
2412-2462 MHz (1-11 channels)

e Metric version:
2412-2472 MHz (1-13 channels)

<+ Transmittable distance:
1Mbps 400 m ™!
2Mbps 270 m ™
5.5Mbps 200 m ™
11Mbps 140 m ™!

1 These figures are a guideline for outdoor use. In general, the transmittable dis-
tance indoors is 10-100 m, depending on environment.

% Transmission mode:
802.11 ad hoc, ad hoc, and infrastructure mode
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IEEE 1284 Parallel Board Type 1

% Transmission spec.:
IEEE 1284

+«* Required cable
Standard IEEE 1284 compliant Micro Centronics 36 pin cable

& Note
O Use the cable supplied with this machine.

PostScript3 Board Type 2

A Reference
PostScript3

Memory Unit Type C 128MB/256MB

% Module Type:
SO-DIMM (Small Outline Dual-in-line Memory Module)

% Memory Type:
SDRAM (Synchronous Dynamic RAM)

« Number of Pins:
144 pins

Extension HDD Type 1

« Data Capacity
40 GB or more
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